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1  ALTA 7 Training Guide

1.1  About this Training Guide
This training guide is intended to provide you with many examples of ALTA 7 Standard (ALTA 7)
and ALTA 7 PRO. It begins with step-by-step examples and then proceeds into more advanced
examples and questions, including examples specific to ALTA 7 PRO. At any time during the
training, please feel free to ask the instructor(s) any questions you might have.

If you have a demonstration version of ALTA 7 or ALTA 7 PRO, you may not be able to save your
work for these examples. For this reason, you may wish to work with the sample projects that are
shipped with the software instead of creating your own. The name of the file that is shipped with the
application and the Folio used is given for each example in this training guide.

1.2  ALTA 7 Documentation
Like all of ReliaSoft's standard software
products, ALTA 7 is shipped with detailed
printed documentation on the product
(ALTA 7 User's Guide) and the underlying
principles and theory (ReliaSoft's
Accelerated Life Testing Reference). This
training guide is intended to be a
supplement to those references.
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1.3  Contacting ReliaSoft
ReliaSoft can be reached at:

ReliaSoft Corporation
Worldwide Headquarters

1450 S. Eastside Loop
Tucson, AZ 85710-6703   USA

Phone: +1.520.886.0366
Fax: +1.520.886.0399

E-mail: Support@ReliaSoft.com

For up-to-date product information, visit our Web site at: 
http://ALTA.ReliaSoft.com 



2  Features Summary

2.1  ALTA 7 Standard and ALTA 7 PRO
ReliaSoft offers two versions of ALTA 7, Standard (ALTA 7) and Professional (ALTA 7 PRO). ALTA
7 Standard includes all the analytical capabilities of ALTA 6 along with many upgrades and additions.
The standard version is an entry-level tool for the reliability professional interested in basic
quantitative accelerated life testing applications. ALTA 7 PRO includes all of the features of the
standard version and unleashes years of research and development in implementing advanced
techniques, including the ability to analyze time-varying stresses. 

The examples included in this training guide have been designed to introduce you to the features
available in ALTA 7 and ALTA 7 PRO. This section presents a brief summary of the features in both
versions of ALTA 7. If you are already familiar with ALTA's features, you can proceed to Chapter 3,
First Steps.

2.2  What’s New in Version 7
ALTA 7 provides more extensive planning, analysis and reporting capabilities than ever before, all in
an easy-to-use package. Specific additions and enhancements include:

• Enhanced Interface: This intuitive, flexible and completely integrated work center, designed
around the Data Folio (similar to an Excel® worksheet), allows you to manage multiple analysis
folios and related information all together in a single file. Using the “Project Explorer” approach
that is employed in ReliaSoft’s Weibull++ and BlockSim software, ALTA now provides an
intuitive, hierarchical (tree) structure to allow you to view and manage one or many standard
folios, specialized folios, plot sheets, stress profiles, spreadsheet reports and/or attached
documents per project. At the same time, the new work environment “stays true to its roots” so
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that users who are familiar with previous versions of the software will be able to enter and analyze data
in much the same way as always. 

• Additional Life Data Types are now supported. In addition to complete and right censored data, you
can now enter interval censored and/or left censored data as well. Data can be entered either
individually or in groups.

• New Life-Stress Modeling Capabilities: In addition to the Arrhenius, Eyring, inverse power law,
temperature-humidity and temperature-nonthermal life-stress models available in ALTA 7 Standard,
ALTA 7 PRO provides the proportional hazards, general log-linear and cumulative damage models.
ALTA 7 PRO now also offers the generalized Eyring model. In addition, the cumulative damage model
now supports multiple time-varying stresses.

• Additional Degradation Analysis Models: In addition to the linear, exponential, power and
logarithmic degradation analysis models, ALTA 7 now provides the Gompertz and Lloyd-Lipow
models as well. 

• Stress Profiles are now managed in a Folio-type format, making it easy to manage multiple time-
varying stresses within a single project. Instead of managing the Stress Profiles in libraries, you can
select one, some or all to quickly and simply import from/export to other projects. 

• Accelerated Life Test Planning Utility helps you design an efficient testing plan, accounting for the
type of stress, method of applying stress, stress levels, number of units to be tested at each stress level
and an applicable accelerated life testing model that relates the failure times at accelerated conditions to
those at normal conditions.

• Template-Based Report Generation allows you to create and format reports with ease, using the same
powerful tools and functions available in General Spreadsheets. Save your reports as templates for re-
use, or use one of the templates included with the software. 

• Integration with Weibull++ 7: If you have Weibull++ 7.5 or later installed on your computer, the
applications will work in concert. Include all of the analysis types available in both ALTA and
Weibull++ in a single project and switch between applications with the click of a button! 

2.3  All the Tools You Need for Accelerated Life Testing Analysis
ALTA provides all of the tools that you need for accelerated life testing analysis, including flexible options
for data type, life-stress model and lifetime distribution.

2.3.1  Support for All Life Data Types
ALTA 7 now supports all life data types, including interval and left censored data, new in Version 7.  You
can also alter the data type in the current Standard Folio Data Sheet at any time with the Alter Data Type
command. 

The data types available in ALTA 7 include:

• Non-Grouped Data Entry

Times-to-failure data (non-censored)

Times-to-failure with right censored (suspended) data

Times-to-failure with interval and/or left censored data

• Grouped Data Entry

Times-to-failure data (non-censored)

Times-to-failure with right censored (suspended) data
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Times-to-failure with interval and/or left censored data

2.3.2  Available Life-Stress Models and Life Distributions
ALTA 7 supports the time-independent one or two stress Arrhenius, Eyring, inverse power law, temperature-
humidity and temperature-nonthermal life-stress models. You can select to solve these life-stress models
with an underlying Weibull, exponential or lognormal life distribution. Maximum likelihood estimation
(MLE) is used for all parameter calculations.

In addition, ALTA 7 PRO offers four additional life-stress models: generalized Eyring, proportional hazards,
general log-linear and cumulative damage.

The generalized Eyring model allows you to analyze data with two stresses and considers the interaction
between the stresses. The flexible general log-linear model allows you to analyze data with up to eight stress
types and to specify an exponential, Arrhenius or power transformation for each stress. The proportional
hazards model also allows you to analyze data with up to eight stress types using the exponential relation
and allows the use of zero as a stress value. The cumulative damage model allows you to analyze data with
up to eight stress levels that vary with time and to specify an exponential, Arrhenius or power transformation
for each stress.

Once you have selected a life-stress model, you can use ReliaSoft’s Distribution Wizard to determine the
best life distribution for your current data. The Distribution Wizard estimates the parameters for each of the
selected distributions and compares the log-likelihood values, then recommends the one that best fits your
data set. You can use Monte Carlo simulation to generate sample data sets based on any of the supported
life-stress models and lifetime distributions. This can include complete data, right censored, interval
censored and/or left censored data points, according to your specifications.

2.3.2.1  Theory Help
Theory help is available for each life-stress model, underlying life distribution and plot type to better help
you understand how ALTA works and how its functions apply to your data. Just click the Theory help button
next to your selection and a window will appear with a brief overview of the principles and theory behind
your selection.

2.3.3  Managing Stresses
ALTA 7 offers several simple yet powerful ways manage the stress types and stress levels in your data sets.

• You can view or modify the use stress level(s) at any point in the analysis using the Use Stress Level
widow.

• You can specify which stress columns are considered when the parameters are calculated in the Select
Stress Columns window.

• You can select a stress transformation for each of the selected stresses to be used when the parameters
are calculated with the general log-linear life-stress model or the cumulative damage life-stress model in
the Stress Transformation window. The general log-linear and cumulative damage models are available
only in ALTA 7 PRO.

• In ALTA 7 PRO, you can create profiles for stresses that vary over a period of time, such as step-
stresses, ramp stresses and any other quantifiable stress profile. You can assign these stress profiles to
data points in the current Standard Folio, which will be analyzed when the parameters are calculated.
The stress profiles can also be used in the Monte Carlo data simulation utility and the SimuMatic tool.
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2.3.4  Accelerated Life Test Plans
Version 7 introduces the new Accelerated Life Test Plans utility, designed to assist you in planning an
accelerated life test that will yield the closest possible estimate of product life at the desired percentile and
use stress level. Extensive customization options allow you to specify the type of test plan you want to
create, whether to account for one or two stresses, the number of units to be tested at each stress level, the
length of the test, etc. The Test Plan will include the stress levels to use in the test, the percentage of total test
units that should be tested at each of those stress levels, an estimate of the time when the specified
percentage of units will have failed at use stress, and more. 

2.3.5  Degradation Analysis
Degradation Analysis Folios allow you to extrapolate the failure times of a product based on its performance
(or degradation) over a period of time under accelerated stress conditions. You can transfer the extrapolated
failure times into a Standard Folio for further analysis or integrate the two types of folios so that changes in
the Degradation Analysis Folio will automatically be reflected in the Standard Folio. 

2.4  Results and Plots at the Click of a Button
Always a strength of ALTA, Version 7 continues to make it easy to calculate and present your analysis
results in ways that effectively support decision-making. 

2.4.1  Quick Calculation Pad
The Quick Calculation Pad (QCP) provides a quick, easy and accurate way for you to obtain results for the
most frequently asked reliability questions. This includes Reliability or Probability of Failure, Failure Rate,
Warranty Time for a given reliability, B(X) Life, Acceleration Factor and Mean Life calculations. The utility
also returns the conditional reliability or probability of failure given the starting age. 

2.4.2  Plots and Graphics to Showcase Your Analyses
ALTA continues to offer unparalleled plotting capabilities to demonstrate your analyses visually. You can
generate probability, use level, reliability vs. time, unreliability vs. time, pdf, failure rate vs. time, life vs.
stress, standard deviation vs. stress, acceleration factor vs. stress and residuals plots with the click of a
button. The Plot Setup allows you to configure the appearance of plot output and the software also provides
a Chart Wizard to create your own custom charts. All plot graphics are metafiles that can be pasted or
inserted into other reports and presentations.

The MultiPlot makes it easy to compare analyses by automatically plotting the results for multiple data sets
together in the same plot. The Side-by-Side Plots utility allows you to view (and print) multiple plots for a
given data set side-by-side. For example, you may want to show the probability, reliability, pdf and failure
rate plots for a given analysis together in the same window. Alternatively, you may wish to compare the
probability or pdf plots for a given data set when analyzed with different life-stress models or distributions.
Simply select the combination that meets your analysis/reporting needs. You can use RS Draw, ReliaSoft’s
integrated metafile graphics editor, to edit and annotate the plots generated by ALTA. This utility allows you
to insert text, highlight a point or line, mark the coordinates of a point, and much more.

In addition, you can use ReliaSoft’s 3D Plot utility to generate a variety of three-dimensional plots. View,
print or even modify three-dimensional likelihood function, pdf, failure rate, reliability and unreliability
plots in moments!

2.5  Additional Tools and Wizards
ALTA also provides many additional tools and wizards designed to streamline, enhance and supplement
your analyses.



Features Summary ALTA 7

                                          http://ALTA.ReliaSoft.com   7

2.5.1  Spreadsheets for Custom Analyses
General Spreadsheets, which can be incorporated into any ALTA Standard Folio, are used just like an
Excel® worksheet to perform your own customized analyses. These spreadsheets provide complete in-cell
formula support, cell references, over 200 built-in functions and integration with the Function Wizard and
the Chart Wizard. You can use the Function Wizard to insert a wide array of calculated results based on your
inputs and, when applicable, a referenced Data Sheet. Available results range from basic math/statistical
functions to common reliability analysis results, and much more. In Version 7, this now works more like
Excel functions, with the ability to type functions directly into cells and results that are updated
automatically when the inputs change. The Chart Wizard leads you through a step-by-step process to create
and configure your own custom charts/plots based on a selected data set. 

2.5.2  Template-Based Report Generator
The Report Wizard utility allows you to design print-ready reports to showcase your analyses. The template
feature makes it easy to apply the same report format to different analyses. This utility has been revised and
enhanced in Version 7 and now provides an intuitive spreadsheet-based interface for creating and formatting
reports. 

2.5.3  References and Wizards
• Quick Statistical Reference: Frees you from tedious lookups in tables by returning results for common

statistical functions, such as Median Ranks, Chi-Squared values and more at the click of a button. 

• Likelihood Ratio Test: Allows you to validate the consistency of the shape parameter, beta or standard
deviation, across multiple stress levels for the currently calculated data set.

• Design of Reliability Tests: Determine the appropriate sample size, test duration or other variable for a
reliability demonstration test. Parametric Binomial, Non-Parametric Binomial and Exponential Chi-
Squared methods are available and results are displayed in both tables and plots.

• Tests of Comparison Wizard: Compare two data sets to determine whether items from the first set will
outlast those of the second.

• Parameter Experimenter: Solve for a parameter of a distribution given the other parameter(s) and one
data point (unreliability at a given time) or solve for all parameters of a distribution given two
unreliability data points.

• Non-Linear Equation Root Finder: Iteratively solve for a real root of an unconstrained non-linear
function using a variable order improved memory method.

2.6  Data Import and Integration with Other ReliaSoft Software
In addition to providing a variety of data sheet formats designed to fit your particular data and analysis
requirements, ALTA makes it easy to import data from outside sources, including: ALTA 1.0, 6.0 or 6.5;
Weibull++ 4, 5, 6 or MT; Excel® and Tab, Comma, Space or Semi-colon delimited files.

If you have Weibull++ 7.5 or later installed on your computer, ALTA and Weibull++ will work together to
expand your analysis capabilities and to save you time and effort. A single project can now include ALTA’s
Standard Accelerated Life Data Analysis Folios and Weibull++’s Standard Life Data Analysis Folios, in
addition to all of the types of Specialized Folios, Additional Plots, Stress Profiles, Other Tools, Reports and
Attachments available in both applications. Switch between applications with the click of a button!

2.7  Configure the Workspace to Meet Individual Needs
ALTA makes it easy to configure the interface and analysis settings to meet your specific preferences and
needs. For example, the User Setup allows you to specify default options for data sheets, analysis settings,
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fonts/symbols, etc. The Plot Setup allows you to configure the appearance of the plots that are automatically
generated by the software. In addition, you can customize the toolbars and/or adjust the appearance of the
workspace by hiding/displaying or changing the position of the Project Explorer and other panels.

2.8  System Requirements
ALTA Version 7 is compiled and designed for Windows NT, 2000 and XP and takes advantage of the
features available in these platforms. Minimum system requirements: A 433-MHz Intel Pentium-class
processor or equivalent, with 32MB RAM (64MB or more is recommended), SVGA display and at least 80
MB of hard disk space. 



3  First Steps

3.1  Starting ALTA 7
ALTA is a 32-bit application that has been designed to work with Windows NT, 2000 and XP. The
internal screens and commands are identical regardless of which operating system you are using, and
this training guide is equally applicable. To start ALTA, from Start select Programs, ReliaSoft
Office and then ALTA 7. 

3.2  ALTA Nomenclature
Within ALTA and this training guide, the terms “stress type” and “stress” will be used
interchangeably. They refer to the type of stress that is being applied to the product under test.
Temperature, humidity and voltage are all stress types or stresses. The term “stress level” refers to the
different measurements or levels for a specified stress or combination of stresses that were used to
conduct a test. For example, suppose that a test was conducted using temperature as the accelerating
stress. The temperatures used were 400K, 500K and 600K and the product is expected to operate
normally at a temperature of 300K. Therefore, temperature is the stress type; 400K, 500K and 600K
are the stress levels; and 300K is the use stress level for that particular stress type. 

3.3  Multiple Document Interface and Standard Folio
The Multiple Document Interface (MDI) is the main window and “manager” for ALTA. The MDI
serves as the container for the Project Explorer, all Standard Folios, Specialized Folios, Additional
Plots, Stress Profiles, Other Tools, Reports and Attachments and manages the different active
windows. The MDI remains open until you close the program. Closing the MDI has the same effect as
terminating the program. The next figure shows the MDI of ALTA 7 and its components. The
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appearance of the MDI will vary depending on the window(s) that are currently open and the configuration
settings of the Project Explorer.

The Standard Folio, used for accelerated life data analysis, is the most commonly used Folio in the
application. The Standard Folio organizes the entered data in the appropriate Data Sheet and calculates the
results. It also contains any Plots and General Spreadsheets associated with the analysis. Each Standard
Folio can contain up to 256 data sheets with up to 65,536 data rows per sheet. A Standard Folio is shown in
the figure below.

3.4  Getting Help in the ALTA 7 Environment
ReliaSoft's ALTA 7 includes complete on-line help documentation. This help can be obtained at any time by
pressing F1 or by selecting Contents from the Help menu. ALTA 7 also provides theory help, which is
available for each life-stress model, underlying life distribution and plot type. Theory help can be accessed
by clicking the theory help button (?) next to your selection.



First Steps ALTA 7

     http://ALTA.ReliaSoft.com     11

3.5  A Quick Overview Example
This section presents you with a very simple example and guides you through the solution. The test case for
this example: Five units were reliability tested at a stress level of 406K and the following times-to-failure
were observed: 248, 456, 528, 731 and 813 hr. Six units were reliability tested at a stress level of 416K and
the following times-to-failure were observed: 164, 176, 289, 319, 340 and 543. Six units were reliability
tested at a stress level of 426K and the following times-to-failure were observed: 92, 105, 155, 184, 219 and
235. The use stress level is 356K. The steps to complete the analysis are presented next.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “1stSteps.ralp.”

• Create a new project by clicking Create a New Project in the initial window that may appear at startup,
by selecting New from the File menu or by clicking the New icon.

The Project Wizard will be displayed. This wizard guides you through the steps required to create a new
project that will meet your analysis needs. The steps displayed will vary depending on your selections for
each page. Note that you can click Finish from the first page of the wizard to create another project with the
same settings as the last project you created. You may also choose to create a new project with items
imported from an existing project or based on a saved profile.

• On the first page of the Project Wizard, select to create a new project By following the wizard and click
Next> to proceed to the next step.
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• On the second page of the Project Wizard, make sure that Accelerated Life Data Analysis Folio is
selected and click Next> to proceed to the next step..

• In this example, you will be working with non-grouped times-to-failure data without suspensions, so on
the third page of the Project Wizard, make sure that none of the checkboxes on the page are selected.
Click Next> to proceed to the next step.
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• On the fourth page of the Project Wizard, select the first stress, Temperature, and enter 356 in the Use
Value field for that stress. Note that the units are already listed as Kelvin (K), so you do not need to
change that field. Make sure all other stresses are deselected and click Next.

• On the last page, click Finish to create the new project according to your specifications. The project
will now include one Standard Folio with a Data Sheet that has been configured to accept the type of
data that you will be entering for this example, as shown next. 

Notice that the heading of the second column displays the stress name and stress units, which were defined
in the Project Wizard.
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• Type the times-to-failure data in the first column of the Data Sheet under Time Failed. Enter the
corresponding temperature stress values for each time-to-failure in the second column under
Temperature K, as shown next. 

Note that the times-to-failure do not need to be sorted; the application will do this for you automatically. 

• The next step is to select a life-stress model and an underlying life distribution to calculate the
parameters. We assume that you have not changed any of the default settings. The default life-stress
relationship is Arrhenius. You can verify this by noticing that Arrhenius is selected from the Model
drop-down menu on the top of the Standard Folio Control Panel’s Main Page, as shown next.

• The Weibull distribution is the default underlying life distribution. You can verify this in the
Distribution drop-down menu on the Standard Folio Control Panel’s Main Page, as shown next.

• All calculations in ALTA 7 use MLE (Maximum Likelihood Estimation) as the parameter estimation
method. You can check this by looking at the Information area at the bottom of the  Standard Folio
Control Panel’s Main Page, as shown next.  

• Once the life-stress model and distribution have been selected, you can calculate the parameters by
clicking the Calculate icon,
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or by selecting Calculate from the Data menu. The Standard Folio with its parameters calculated is
shown next. The estimated parameters will appear in the Results Area, which is located just below the
Distribution area.

3.5.1  Plotting the Data
• Plot the data by selecting Plot from the Data menu or by clicking the Plot icon. This icon is displayed

in both the Data Analysis Tools toolbar and in the Control Panel.

A new sheet called “Plot of Data 1” will be added to the Folio. The Use Level Probability plot will be
displayed by default, as shown next.1 

The plot shows the data plotted at the use stress level (356K). 

1. If necessary, you may wish to re-size the plot by re-sizing the Folio. 
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The Plot Sheet provides many options for creating and configuring plots to meet your particular analysis and
presentation needs. You may wish to experiment with some of these options at this time. If the Auto Refresh
command is enabled, the display will be updated automatically to fit your new selections. If not, select
Redraw Plot from the Plot menu or click the Redraw Plot icon to implement your selections. 

For example, the Plot Type menu in the Control Panel allows you to create other types of plots. 

You can switch between the Plot Sheet and the Data Sheet using the page index tabs. However, if you edit
the data on the Data Sheet, you must recalculate the parameters and refresh the plot on the Plot Sheet for the
change to take effect in the plot.

Notice that the analysis settings are displayed in the legend in the top right corner of the plot and the
calculated parameters are displayed in the bottom left corner. You can customize these and other display
settings from the Plot Setup window. To access the Plot Setup, select Plot Setup from the Plot menu or click
the Plot Setup icon.

• When you are finished experimenting with the Plot Setup window, save the project by selecting Save
from the File menu or by clicking the Save icon.

• When prompted to specify the name and location for the file, browse to the directory of your choice and
type “1stSteps” for the File name.2 Select the file type *.ralp and click Save to close the window and
save the file. 

• Close the project by selecting Close from the File menu. You will now be looking at the MDI with no
project open.

2. By default, files will be saved in the “My Documents” directory on your computer. You can select a different
directory, if desired, and ALTA will “remember” the directory for the next time that you save a file.



4  ALTA 7 Standard Examples

This chapter presents the following examples, which can be performed using both ALTA 7 Standard
and ALTA 7 PRO:

• Example 1: Accelerated Life Testing Data Analysis with Complete Data and a Single Stress -
page 18

• Example 2: Obtain the Unreliability for a Given Operating Time - page 22

• Example 3: Calculate Conditional Reliability and Warranty Time - page 25

• Example 4: Analysis Using Two Stresses - page 30

• Example 5: Grouped Data - page 36

• Example 6: Confidence Bounds - page 39

• Example 7: Analysis with Right Censored Data - page 40

• Example 8: Plotting Confidence Bounds - page 45

• Example 9: Use the General Spreadsheet and Function Wizard - page 48

• Example 10: 3-D Plots - page 52

• Example 11: Determining Activation Energy, B(10) Life and Acceleration Factor, Using Reports
for Further Analysis - page 54

• Example 12: Degradation Data Analysis - page 58

• Example 13: Performing a Likelihood Ratio Test - page 62

• Example 14: Creating an Accelerated Life Test Plan - page 65

Chapter 5 presents examples that are specific to ALTA 7 PRO.
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4.1  Example 1: Accelerated Life Testing Data Analysis with Complete Data
and a Single Stress
Since the life of a new product under normal operating conditions is expected to be more than 15,000 hr,
testing under these conditions is not time-wise feasible. For this reason, it was decided to run an accelerated
test for this product. The operating temperature for this product is 323K (50°C) and temperature is the only
acceleration variable. A table of the data obtained from the test for three different accelerated stress levels is
given next.

Do the following:

• Determine the parameters of the Arrhenius-Weibull model.

• Create the Use Level Weibull Probability and Weibull Probability plots. 

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Complete Data” Folio.

Solution

• Create a new project by clicking Create a New Project in the initial window that may appear at startup,
by selecting New... from the File menu or by clicking the New icon.

• Select By following the wizard on the first page of the Project Wizard and Accelerated Life Data
Analysis Folio on the second page.

• On the third page, make sure that none of the checkboxes on the page are selected.

Stress Level, K 393K 408K 423K

Times-to-Failure, hr

3850 3300 2750
4340 3720 3100
4760 4080 3400
5320 4560 3800
5740 4920 4100
6160 5280 4400
6580 5640 4700
7140 6120 5100
7980 6840 5700
8960 7680 6400
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• On the fourth page, select the first stress, Temperature, and enter 323 in the Use Value field for that
stress, as shown next.

• Click Finish to create the new project with the appropriate Standard Folio. 

• Type the times-to-failure data in the first column of the Data Sheet under Time Failed. Enter the
corresponding temperature stress values for each time-to-failure in the second column under
Temperature K, as shown next. Please note that the figure shown only displays 20 rows of data. Be
sure to enter all data for this example as given on page 18. Your Data Sheet should contain 30 rows of
data.

• The next step is to select a life-stress model and a distribution. On the Standard Folio Control Panel’s
Main Page, select Arrhenius under Model and Weibull under Distribution, as shown above.

• Calculate the parameters by clicking the Calculate icon,
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or by selecting Calculate from the Data menu. The results will appear in the Results area, as shown
next.

• Plot the data by selecting Plot from the Data menu or by clicking the Plot icon.

The Use Level Weibull Probability plot for this data is shown next. 

The Use Level Weibull Probability plot is based on the value of the use stress level that you entered when
you created the Data Sheet, 323K. Changing the value of the use stress level will change the location of the
probability plot. 



ALTA 7 Standard Examples                                                                                                                           ALTA 7

      http://ALTA.ReliaSoft.com     21

• Plot the Weibull Probability plot by selecting Probability-Weibull from the Plot Type drop-down
menu on the Control Panel.

The Weibull Probability plot is shown next.

• Notice that each accelerated stress level is plotted on the probability plot along with the use stress level.
You can select which stress levels appear on the plot using the Show/Hide Plot Items window, which
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can be opened by selecting Show/Hide Items from the Plot menu. The  Show/Hide Plot Items window
is shown next.

This window allows you to select the data you want displayed on the plot and how you want it displayed (i.e.
points and/or lines).

• For each stress level from the current Data Sheet, decide if you want points and/or lines representing
that stress level to appear on the plot and make the appropriate selections. Note that only a line is
available for the Use Stress Level, as there were no observations actually made at that stress level

• Click OK to accept your selections and return to the Plot Sheet.

• Return to the Data Sheet by clicking the Data 1 tab at the bottom of the Folio.

• Save the project by selecting Save from the File menu or by clicking the Save icon.

• When prompted to specify the name and location for the file, browse to the directory of your choice and
type “Training Examples” for the File name.1 Select the *.ralp file type and click Save to close the
window and save the file.

• Leave the project and Folio open and proceed to the next example.

4.2  Example 2: Obtain the Unreliability for a Given Operating Time
What is the unreliability of the units in Example 1 for a mission duration of 9,000 hr, starting the mission at
T = 0 with an operating stress level of 323K?

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Complete Data” Folio.

Solution

There are two methods of solution for this problem. The first and more laborious method is to extract the
information directly from the plot. This can be done using ReliaSoft Draw (RS Draw).2 The second method
is to use ALTA's Quick Calculation Pad (QCP) to obtain the exact result. Both methods are presented next.

1. By default, files will be saved in the “My Documents” directory on your computer. You can select a different
directory, if desired, and ALTA will “remember” the directory for the next time that you save a file.
2. RS Draw is presented in detail in Chapter 11 of the ALTA User's Guide. 
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• If Folio1 from the “Training Examples.ralp” project file that you created in the first example is not
already active, open the project by selecting Open from the File menu or by clicking the Open icon.

• Browse for the “Training Examples.ralp” file and click Open.

• Click the “plus” (+) to the left of the Standard Folios branch in the Project Explorer on the left side of
the MDI to display a list of the standard life data analysis folios in the current project. Double-click
Folio1 to open it. The MDI will now look like the figure shown next.

• Click the Plot of Data 1 tab at the bottom of the Folio to display the Plot Sheet. Make sure that the Use
Level Weibull Probability plot is being displayed. For this example, the unreliability for a mission of
9,000 hr is required. However, the minimum value for the X-axis in the use level probability plot is
10,000 hr. You can change the scaling of the plot using the X and Y scaling boxes on the Plot Sheet
Control Panel.

• First, de-select the Automatic Scaling option above the scaling boxes to disable the automatic scaling.
This will activate the X and Y scaling boxes. Next, enter the new value within the appropriate input box.
In this case, change the lower limit of the X-axis from 10,000 to 1,000, as shown next. 
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• After typing the new value, press Enter if the Auto Refresh option is selected. If the Auto Refresh
option is not selected, click the Refresh icon. 

• After the plot has been refreshed, click the RS Draw icon,

or select Edit Plot with RS Draw from the Tools menu. RS Draw can automatically track the position
of the mouse cursor and translate the coordinates for you. Obtain the unreliability at T = 9,000 hr by
placing the cursor at the intersection of the plotted line and T = 9,000. The position of the cursor is
indicated by the Position Indicator located in the lower right corner of the RS Draw window. The x-
coordinate (time) is displayed on the left and the y-coordinate (unreliability) is displayed on the right.
When the x-coordinate reads approximately 9,000, read off the value of the y-coordinate. You may not
be able to obtain the value of the unreliability at exactly 9,000 hours. This is one of the disadvantages of
reading the value off the plot. The position of the cursor at the intersection of the plotted line and

 is shown next.

From the Position Indicator, the value of the y-coordinate, the unreliability Q(T), is such that
%. Therefore, a good estimate of the probability of failure (unreliability) at 9,000 hours is

3.966%. 

• Close RS Draw. Return to the Data Sheet by clicking the Data 1 page index tab.

T 9000≅

Q T( ) 3.966≅
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• The second method involves the use of the Quick Calculation Pad (QCP). Open the Quick Calculation
Pad by selecting Quick Calculation Pad from the Data menu or by clicking its icon.

• On the Basic Calculations page, make the following selections/inputs:

•  Options for Calculations: Std. Prob. Calculations

•  Results Options: Results as Probability of Failure

•  Required Input From User:

Temperature = 323
Mission End Time = 9000

• Click Calculate to obtain the results, as shown next.

The QCP returns a result of Q(T) = 4.16%. This is similar to the result found using the plot. However,
the QCP is more accurate and easier to use. 

• Close the QCP, save any changes, leave the project and Folio open and proceed to the next example.

4.3  Example 3: Calculate Conditional Reliability and Warranty Time
Using the analysis from Example 1, what is the reliability for a mission duration of T = 3,000 hr, starting the
mission at T = 6,000 hr at a use stress level of 323K? Also, what is the warranty time for a reliability of 99%
at the same stress level?

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Complete Data” Folio.
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Solution

• If Folio1 from the “Training Examples.ralp” project file that you created in the first example is not
already active, open the project and Folio now.

• Open the Quick Calculation Pad by selecting Quick Calculation Pad from the Data menu or by
clicking its icon.

• On the Basic Calculations page, make the following selections/inputs:

•  Options for Calculations: Conditional Calculations

•  Results Options:  Results as Reliability

•  Required Input From User:

Temperature = 323
Mission Start Time = 6000
Mission Additional Time = 3000

•  Click Calculate to obtain the results, as shown next.

The conditional reliability starting the mission at 6,000 hr and for a 3,000 hr duration is equal to 96.56%.
This satisfies the first part of the example.

The second part of the example requires the determination of the warranty time for a reliability of 99%.
There are multiple ways to obtain this information using ALTA 7. They include:

• Use the Warranty (Time) Information calculation in the Quick Calculation Pad to calculate the value.
This calculation is the fastest and most accurate method and is described below (first).
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• Use the Life vs. Stress plot and the Specify Life Lines option. This graphical method is described below
(second).

• Use the Use Level Weibull Probability plot and RS Draw. This is similar to the procedure described on
page 24 and is not described again here.

To use the QCP calculation method to determine the warranty time for 99% reliability, do the following:

• On the Basic Calculations page, make the following selections/inputs:

•  Options for Calculations: Warranty (Time) Information

•  Required Input from User: Required Reliability = 0.99

• Click Calculate to obtain the results, as shown next.

The time required for a reliability of 99% is equal to 6431.1 hr. 

• Close the QCP by clicking Close.

To use the Life vs. Stress plot graphical method to determine the warranty time for 99% reliability, do the
following:

• Click the Plot of Data 1 page index tab to display the plot of the data. The Use Level Weibull
Probability plot will probably be displayed. Select Automatic Scaling and switch to the Life vs. Stress
plot by selecting Life vs Stress under Plot Type.3  

• For the Life vs. Stress plot, the scale parameter (eta) and imposed pdf will appear on the plot by default.
You can also add up to ten additional lines corresponding to ten different percentiles (unreliabilities) by
following the steps described next. 

3. If Auto Refresh is not selected, you must click the Refresh icon for the changes to take effect on the plot.
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• Click the Life Lines link on the Plot Sheet Control Panel. The Specify Life Lines window will appear.
You can enter up to ten percentile values to be plotted or delete existing values. 

• For this example, select the checkboxes beside the first and second values to display them on the plot.
Enter 1 for the unreliability value for the first line and 99 for the unreliability for the second line, as
shown next.

• Click OK to close this window. 

The refreshed Life vs. Stress plot will look like the one shown next.

The bottom line corresponds to 1% unreliability, the second line is the scale parameter (eta) and the top line
corresponds to 99% unreliability.
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• De-select Automatic Scaling and change the scaling to the values shown next. If Auto Refresh is
selected, press Enter to refresh the plot to reflect the changes made to the scaling. If Auto Refresh is
not selected, then click the Refresh icon.

• Select Edit with RS Draw from the Tools menu or click the RS Draw icon.

• Obtain the time for a 99% reliability (or 1% unreliability) by placing the cursor at the intersection of the
1% unreliability line and stress = 323.

The position of the cursor at the intersection of the plotted line and stress = 323 is shown next.

The value of the y-coordinate from the Position Indicator is equal to 6429.1. Therefore, 6429 hr is a good
estimate of the warranty time for a 99% reliability. This is similar to the value obtained using the QCP.
Again, the QCP is obviously more accurate and easier to use.

• Close RS Draw.

• Close the Folio by clicking the Close button (X) in the top right corner.

• Save any changes, leave the project open and proceed to the next example.
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4.4  Example 4: Analysis Using Two Stresses
Twelve electronic devices were put in a continuous accelerated test. The accelerated stresses were
temperature and voltage, with use level conditions of 328K and 2V. The data obtained are shown in the table
below.

Do the following:

• Calculate the parameters of the Temperature-NonThermal life-stress model and Weibull distribution.

• Obtain the probability plot of the data.

• Estimate the warranty time for a 95% reliability.

• Obtain the Life vs. Stress plot for temperature (Life vs. Temperature).

• Obtain the Life vs. Stress plot for voltage (Life vs. Voltage).

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the “Two
Stresses” Folio.

Solution

• With the “Training Examples.ralp” project open, create a new Standard Folio by selecting Add
Standard Folio... from the Project menu or by right-clicking inside the Project Explorer and selecting
Add Standard Folio... from the shortcut menu.

• The Data Sheet Setup window will appear. You will notice that the two pages of this window are
identical to the third and fourth pages of the Project Wizard when the selected Folio is a Standard Folio.
On the first page of the Data Sheet Setup window, make sure that none of the checkboxes on the page
are selected.

Time, 
hr

Temperature, 
K

Voltage, 
V

620 348 3
632 348 3
658 348 3
822 348 3
380 348 5
416 348 5
460 348 5
596 348 5
216 378 3
246 378 3
332 378 3
400 378 3
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• On the second page, select the first stress, Temperature, and enter 328 in the Use Value field for that
stress. Also select the second stress, Voltage, and enter 2 in the Use Value field for that stress, as shown
next.

• Click Finish to create the Standard Folio. Note that the Project Explorer now displays two Standard
Folios, Folio1 and Folio2.4

• Enter the data into the Data Sheet, as shown next.

• Select Temperature-NonThermal as the life-stress model. Make sure that Weibull is selected as the
distribution or select it as explained in the previous examples.

4. Although the default Folio names have been used for these examples, you can rename Folios to be more descriptive, if
desired, as has been done in the Training Examples.ralp file that accompanies the software. To rename an item in the
Project Explorer, right-click the item and select Rename Item from the shortcut menu or select the item and press F2.
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You will notice that only the Temperature stress column is selected for use in calculation (denoted by red
borders in the column and a check in the box in the column header).  You can select additional columns in
two ways:

• Click the Select Stress Columns link on the Main Page of the Standard Folio Control Panel or select
Select Stress Column(s) from the Data menu. The Select Stress Columns window will appear, as
shown next.

•  Check the box beside Voltage.

•  Because the Temperature-NonThermal life-stress model is selected, you will need to specify
which stress is the thermal stress and which is the nonthermal stress. Select Thermal for
Temperature and NonThermal for Voltage, as shown next, then click OK.

• Instead of using the Select Stress Columns window, you can simply check the checkbox in the header of
each stress column that you want to use. Note, however, that there is no way to specify which stress is
thermal and which is nonthermal for the Temperature-NonThermal model, so ALTA treats the first
selected column as the thermal stress and the second selected column as the nonthermal stress.

• Calculate the parameters by selecting Calculate from the Data menu or by clicking the Calculate icon.
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The calculated parameters are shown next.

• Plot the data by selecting Plot from the Data menu or by clicking the Plot icon.

• The Use Level Weibull Probability plot will appear. Select Probability-Weibull as the Plot Type and
refresh the plot. 

Four lines will appear on the probability plot, including three lines for the three combinations of
stresses: (348K, 3V), (348K, 5V) and (378K, 3V); and one line for the use stress level (328K, 2V).

• Next, use the Quick Calculation Pad to obtain the warranty time for a reliability of 95%. Open the
Quick Calculation Pad by selecting Quick Calculation Pad from the Data menu or by clicking its icon. 
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• On the Basic Calculations page, make the following selections/inputs:

•  Options for Calculations: Warranty (Time) Information

•  Required Input From User: a drop-down menu will appear that contains both stress types, as
shown next. Select a stress type from the menu and enter the corresponding value in the input
box.

Temperature = 328
Voltage = 2
Required Reliability = 0.95

• Click Calculate to obtain the results, as shown next.

The warranty time for a reliability of 95% is 1,003.6465 hr. 

• Close the QCP and return to the Plot Sheet by clicking Close.
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• Select Life vs Stress as the Plot Type in the Plot Sheet Control Panel. The Life vs. Stress plot will
appear, as shown next.  

• Open the Use Stress Level window by clicking the Set Use Stress link on the Control Panel. 

An option labeled Vary appears to the right of each stress type, which allows you to specify for one of the
stresses to be varied while the other stresses are held constant at the use stress level (i.e. if Vary is selected
for one stress, then the other stresses will be held constant.)

In the previous plot, the Temperature stress was varied, which means that the temperature was plotted and
the Voltage stress remained constant at 2V (i.e. the plot showed Life vs. Temperature).

• To obtain a Life vs. Voltage plot, select the Vary option for the Voltage stress, as shown next.

• Click OK to close the window and refresh the plot. 
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The Life vs. Voltage plot for a constant temperature of 328K will appear, as shown next.

• Close the Folio by clicking the Close button (X) in the top right corner.

• Save any changes, leave the project open and proceed to the next example.

4.5  Example 5: Grouped Data
A tensile component of a landing gear was put through an accelerated reliability test to determine whether
the return life goal would be achieved under the designed-in load. Fifteen units, N = 15, were tested at three
different shock loads. The component was designed for a peak shock load of 40 kips with an estimated
return of 10% of the population by 10,000 landings. Using the Inverse Power Law-Lognormal model,
determine whether the designed life requirement was met.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Grouped Data” Folio.

Number of Units Failure, in Landings 
(simulated)

Load, kips

1 1176 73
3 1512 73
1 3528 73
3 624 98
1 816 98
1 1296 98
1 204 123
1 228 123
1 252 123
1 300 123
1 324 123
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Solution

• With the “Training Examples.ralp” project open, create a new Standard Folio by selecting Add
Standard Folio... from the Project menu or by right-clicking inside the Project Explorer and selecting
Add Standard Folio... from the shortcut menu.

• On the first page of the Data Sheet Setup window, select I want to enter data in groups and make sure
no other options are selected.

• On the second page, select Mechanical as the stress type. Change the Name to Load and set the Use
Value to 40, as shown next. 

• Click Finish to create the Folio. 

•  Enter the data, as shown next. Note the titles of the column headings.

• You can change the heading of the second column, currently State End Time, by double-clicking the
heading. A window will appear that allows you to change the heading. Type Simulated Landings and
click OK. The row headings can be changed in the same manner, if desired.
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• Select Inverse Power Law as the life-stress model and Lognormal as the underlying life distribution. 

• Calculate the parameters and then open the QCP by selecting Quick Calculation Pad from the Data
menu or by clicking its icon.

• On the Basic Calculations page, make the following selections/inputs:

•  Options for Calculations: Warranty (Time) Information

•  Required Input from User: 

Load = 40
Required Reliability = 0.9

• Click Calculate to obtain the results, as shown next.

The life is estimated to be 10,545 landings, which meets the design specifications. We will continue this
example and perform further estimations using the QCP in the next section. Keep the QCP open and
proceed to the next example.
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4.6  Example 6: Confidence Bounds
In the previous example, it was found that the 10,000 landings life criteria for a 90% reliability was met.
However, the estimate of 10,545 landings is very close to the requirement. Additionally, this estimate was
obtained at the 50% confidence level. In other words, 50% of the time, life will be greater than 10,545
landings and 50% of the time, life will be less. Repeat the calculation of the previous example and this time
include a 90% lower one-sided confidence bound on the estimation of the Warranty (Time) Information.

• We assume that the QCP is still open from the previous example, and Warranty (Time) is still selected
with a required reliability of 90% and a stress level of 40.

• Next, go to the Confidence Bounds page by clicking the Confidence Bounds tab. Select Show
Confidence Bounds. More options will appear on the page. Under Show Confidence Bounds, select
Lower One-Sided. Enter 0.9 in the Confidence Level box and click Calculate to obtain the results, as
shown next.

The 90% lower limit was estimated to be 6729.9599 landings, which is below the design life of 10,000
landings.

• Close the QCP by clicking Close.

• Close the Folio by clicking the Close button (X) in the top right corner.

• Save any changes, leave the project open and proceed to the next example.
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4.7  Example 7: Analysis with Right Censored Data
The following example involves using a data set that contains suspended (right-censored) data.

A certain electronic unit was put through an accelerated test. The test was performed at four different
temperature levels; 423K, 443K, 463K and 493K. The use stress level is 393K. The data set obtained from
the test is shown next.

Do the following:

• Enter the data. Use the Eyring-Weibull model to calculate the parameters.

• Obtain the Use Level Probability plot.

• Obtain the Reliability vs. Time plot.

• Obtain the pdf plot.

• Obtain the Failure Rate vs. Time plot.

• Obtain the Acceleration Factor vs. Stress plot.

• View all plots at once, including the Life vs. Stress plot, in ALTA's Side-by-Side Plots utility.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Right Censored Data” Folio.

Stress Level, K 423K 443K 463K 493K

Times-to-Failure, hr

- 1764 408 408
- 2772 1120 456
- 3446 1344 504
- 3542 1402 504
- 3780 1440 504
- 4680 - -
- 5196 - -

Stress Level, K 423K 443K 463K 493K

Suspension Times, hr

6064 5448 1680 528
6064 5448 1680 528
6064 5448 1680 528
6064 - 1680 528
6064 - 1680 528
6064 - - -
6064 - - -
6064 - - -
6064 - - -
6064 - - -
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Solution

• With the “Training Examples.ralp” project open, create a new Standard Folio by selecting Add
Standard Folio... from the Project menu or by right-clicking inside the Project Explorer and selecting
Add Standard Folio... from the shortcut menu.

• On the first page of the Data Sheet Setup window, select My data set contains suspensions (right
censored data) and I want to enter data in groups.

• On the second page, select Temperature as the stress type and set the Use Value to 393. Click Finish to
create the Folio.

• Enter the data and select Eyring as the life-stress model and Weibull as the underlying life distribution.

• Calculate the parameters by clicking the Calculate icon. The calculated parameters are shown next.
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• Plot the data. The Use Level Weibull Probability plot will appear, as shown next.

• Obtain the Reliability vs. Time plot by selecting Reliability vs Time from the Plot Type drop-down
menu. The Reliability vs. Time plot is shown next.
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• Next, select Pdf Plot from the Plot Type drop-down menu. The Probability Density Function plot is
shown next.

• Select Failure Rate vs Time from the Special Plot Type drop-down menu to obtain the Failure Rate vs.
Time plot. The Failure Rate vs. Time plot is shown next.
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• Select AF vs Stress from the Plot Type drop-down menu to obtain the Acceleration Factor vs. Stress
plot. The Acceleration Factor vs. Stress plot is shown next.

If you would like to view all of these plots at the same time, along with the Life vs. Stress plot, you can use
the Side-by-Side Plots utility. Side-by-Side Plots is available from the Plot Sheet and uses the data, life-
stress relationship and distribution from the linked Data Sheet. All plot properties are set to the default
settings. With Side-by-Side Plots, you can select from twelve different plot types, three different
distributions or five different models to view at once.5 

• To open Side-by-Side Plots, click its icon.

The Side-by-Side Plots window will open.

• On the Side-by-Side Plots Control Panel, in the Vary area, select the Plot Types option. Twelve plot
types will appear. Select to view the Use Level, Reliability, Pdf, Failure Rate, Life vs. Stress and AF
vs. Stress plots by clicking the boxes to the left of the corresponding plot types.

5. Note that in ALTA 7 PRO, there are nine different models from which to choose, rather than five.
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• Click the Refresh Plots button to refresh the plot area to reflect your selections. All six plots will appear
in the plot area, as shown next.

• Close the Side-by-Side Plots window and the Folio. 

• Save any changes, leave the project open and proceed to the next example.

4.8  Example 8: Plotting Confidence Bounds
In Example 6, you used the QCP to estimate the lower confidence level at a given percentile. This example
demonstrates plotting confidence bounds. The use stress level for the following data set is 323K.

Number of Units State Time-to-Failure Temperature
1 Failed 10512 363
3 Failed 11856 363
6 Suspended 12191 363
3 Failed 2436 393
1 Suspended 2436 393
1 Suspended 2772 393
1 Failed 3109 393
4 Suspended 4117 393
1 Suspended 1175 413
1 Failed 1763 413
7 Suspended 1882 413
1 Suspended 1954 413
1 Suspended 1129 433
1 Suspended 1511 433
1 Suspended 1607 433
6 Suspended 1633 433
1 Failed 1895 433
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Do the following:

• Determine the parameters for the data using the Arrhenius life-stress relationship and lognormal
distribution.

• Obtain the Use Level Lognormal Probability plot for the data with 90%, two-sided Percentile (Type 1)
confidence bounds.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Plots and Spreadsheets” Folio.

Solution

• With the “Training Examples.ralp” project open, create a new Standard Folio.

• On the first page of the Data Sheet Setup window, select My data set contains suspensions (right
censored data) and I want to enter data in groups.

• On the second page, select Temperature as the stress type and set the Use Value to 323. Click Finish to
create the Folio.

• Enter the data and select Arrhenius as the life-stress model and Lognormal as the underlying life
distribution. Calculate the parameters. The next figure displays the results.
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• Create a Lognormal Probability plot by clicking the Plot icon. The Use Level Lognormal Probability
plot will appear on the Plot Sheet, as shown next.

• To plot the confidence bounds, select Confidence Bounds from the Plot menu or click the Confidence
Bounds link on the Control Panel. The  Confidence Bounds window will appear, as shown next.

• Select Two Sided from the Sides options and Time (Type 1) from the Type options. Type 90 for the
Confidence Level (%) and click OK.
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The Use Level Probability plot with confidence bounds is shown next.

Notice that the legend now contains information about the plotted confidence bounds.

• Return to the Data Sheet by clicking the Data 1 page index tab. Save any changes, leave the project and
Folio open and proceed to the next example.

4.9  Example 9: Use the General Spreadsheet and Function Wizard
Using the data from Example 8, obtain tabulated values for the failure rate for six different mission end
times. The mission end times are 15,000 to 20,000 hr, incremented by 1,000 hr. 

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Plots and Spreadsheets” Folio.

Solution

You can easily accomplish this via the use of the Function Wizard within the General Spreadsheet.6 The
General Spreadsheet is very similar to an Excel® spreadsheet. You can input formulas and edit the cells in a
similar manner. The Function Wizard allows you to insert a wide array of calculated results based on your
inputs and, when applicable, a referenced Data Sheet.

• If Folio5 from the “Training Examples.ralp” project is not already active, open the project and Folio
now.

• Insert a General Spreadsheet by selecting Insert General Spreadsheet from the Folio menu or by
clicking the icon in the Folio Tools toolbar.

6. The General Spreadsheet is presented in detail in Chapter 16 of the ALTA User’s Guide and the Function Wizard is
presented in Chapter 18.
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• Type “Time” in cell A1 and “Failure Rate” in cell B1. Then enter 15,000 through 20,000 in cells A2 to
A7.7 Finally, place the cursor into cell B2, as shown next.

• Open the Function Wizard by selecting Function Wizard from the Data menu or by clicking the
Function Wizard icon.

• Select FAILURERATE_S from the list of functions. Note that the functions are in alphabetical order
and if you click inside the list and start typing the name of the function, the selection will automatically
move to the first function in the list that matches the letters you have typed. Also note that the menu

7. To save time, you could also type the equation “=A2+1000” into cell A3 and then copy/paste the equation through cell
A11.
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above the list allows you to filter the list to display only those functions of a specific type. With the
failure rate function selected, the wizard will look like the figure shown next.

The inputs required for the selected function are displayed on the right side of the window. The text box at
the bottom of the window allows you to build the function that will be inserted into the spreadsheet. 

• Enter A2 for Time. This indicates that the time input for the equation will be obtained from the specified
cell in the worksheet.

• To specify the existing ALTA analysis that the function result will be based on, click Select... to open
the Select Folio/Data Sheet window and then navigate to the desired sheet. If you have been performing
all of the examples in the Training Examples.ralp project as specified in this training guide, this will be
Data 1 in Folio5, as shown next.8

8. If you are using the Training Examples.ralp file included with the software, you will use the Data 1 sheet in the “Plots
and Spreadsheets” Standard Folio.
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• Click OK to close the window and return to the Function Wizard. The wizard will look like the figure
shown next. 

Notice that an additional input field has appeared, based on the selected Data Sheet. This field allows you to
specify the stress level you want to use in the calculation. The default value is the use stress level, taken from
the associated Data Sheet.

• Click Insert to close the window and insert the function code into the General Spreadsheet. Functions
are inserted into the cell that was active when you opened the Function Wizard.

• Copy the function into cells B3 through B7. One way to do this is to position the mouse over the bottom
right corner of cell B2 and when the cursor turns into a plus symbol (+), click and drag the mouse to cell
B7.

By selecting one of the cells that you copied the function into, you can see that the cell reference was
updated to match the current row, as shown next with cell B7 selected.
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The table that you have created displays the failure rate for each time in column A, based on the analysis in
the associated Data Sheet.

• Save any changes, leave the project and Folio open and proceed to the next example.

4.10  Example 10: 3-D Plots
Using the data from Example 8, obtain the following plots:

• pdf vs. Stress

• Reliability vs. Stress

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Plots and Spreadsheets” Folio.

Solution

• Click the Data 1 tab to return to the Data Sheet.

• The pdf vs. Stress and Reliability vs. Stress plots can be obtained by selecting ReliaSoft 3-D Plot from
the Tools menu or by clicking the 3-D Plot icon.

When the 3-D Plot utility is activated, the Likelihood Function plot is displayed by default, as shown next.
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• Select the Pdf plot from the Plot Type drop-down menu. The generated 3-D pdf plot is shown next.

• To rotate the plot, first click the plot. Then, while pressing the CTRL key, hold down the left mouse
button and move the mouse around to rotate the plot.

• To create the Reliability vs. Stress plot, select Reliability from the Plot Type menu. The Reliability vs.
Stress plot is shown next and has been rotated to display a better view.
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• Close the 3-D Plot by clicking the Close icon located on the toolbar and close the Folio.

• Save any changes, leave the project open and proceed to the next example.

4.11  Example 11: Determining Activation Energy, B(10) Life and
Acceleration Factor, Using Reports for Further Analysis
The accelerating stress for an electronic component is temperature. To meet the specified reliability
requirement, the engineer was required to demonstrate with 90% confidence that 90% of the units will
continue to operate for 1,000 hr under normal use conditions of 300K. To save time and money, the engineer
developed an accelerated life test designed to provide the desired reliability results in a shorter period of
time than would be possible with a test performed under normal stress conditions.  

Consider the following times-to-failure and times-to-suspension of an electronic component that was placed
under an accelerated life test at three different stress levels: 353K, 373K and 393K.

Do the following:

• Determine the activation energy.

• Determine the B(10) life of 1,000 hr at a 90% lower one-sided confidence for the use stress level
(300K).

• Plot the Acceleration Factor vs. Stress plot for this example.

• Assuming that 1,000 units will be sold each month, determine the expected number of failures over the
next six months so that an appropriate stock of spare parts can be kept on hand

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Further Analysis” Folio.

Solution

• With the “Training Examples.ralp” project open, create a new Standard Folio.

• On the first page of the Data Sheet Setup window, select My data set contains suspensions (right
censored data) and make sure no other options are selected.

• On the second page, select Temperature as the stress type and set the Use Value to 300. Click Finish to
create the Folio.

Stress Level Observed Failures Observed Suspensions (hr)
353 K 245 250, 250, 250, 250, 250
373 K 110, 180, 200 250, 250, 250
393 K 50, 70, 88, 112, 140, 160
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• Enter the data and select Arrhenius as the life-stress model and Weibull as the underlying life
distribution. Calculate the parameters. The next figure displays the results.

Notice that the Activation Energy (Ea) appears in the Results area. For this example, the Activation Energy
= 0.4653.

• Next, open the QCP. On the Confidence Bounds page, select Show Confidence and Show Lower One-
Sided. Make sure that the confidence level is set at 90%. 

• On the Basic Calculations page, make the following selections/inputs:

•  Options for Calculations: BX Information

•  Required Input From User:

Temperature = 300
BX% Information At = 10
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• Click Calculate to obtain the results, as shown next..

The B(10) life demonstrated at the 90% lower one-sided confidence is 1,161 hr, which is well above the
required 1,000 hr.

• Close the QCP and return to the Folio. 

• Plot the data. Select AF vs. Stress from the Plot Type drop-down menu. 

• The Acceleration Factor vs. Stress plot is shown next. 
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• Return to the Data Sheet and click the Report Wizard icon in the Control Panel.

• In the Report Wizard, select to create a report Based on an Existing Template and select the Warranty
Forecasts Template, as shown next.9

• Click OK to create the Report. Enter the use stress level of 300 in the Analysis Information area. In the
Warranty Returns Forecasts area, enter 720 in the Time Increment field (24 hours/day * 30 days/month
= 720 hours/month) and enter 1000 for the Future Sales values for Periods 1-5. The window will look
like the figure shown next.

9. Note that if you are using the Training Examples.ralp file included with the software, the Default Data Source will be
Further Analysis!Data1.
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The projected returns for each upcoming month are displayed in the Total Expected Returns area. From
these figures, you can estimate how many spare parts you are likely to need during each time period.

• Close the Report and Folio, save any changes, then proceed to the next example.

4.12  Example 12: Degradation Data Analysis
Consider a chemical solution (e.g. ink formulation, medicine, etc.) that degrades with time. A quantitative
measure of the quality of the product can be obtained. This measure (QM) is said to be around 100 when the
product is first manufactured and decreases with product age. The minimum acceptable value for QM is 50.
Products with QM equal to or lower than 50 are considered to be “out of compliance” or failed. 

Engineering analysis has indicated that QM has a higher rate of decrease at higher temperatures. Assuming
that the product's normal use temperature is 20º C (or 293K), the goal is to determine the shelf life of the
product via an accelerated degradation test. For the purpose of this analysis, “shelf life” is defined as the
time by which 10% of the products will have a QM that is out of compliance.

For this experiment, fifteen samples of the product were tested, with five samples in each of three
environments: 323K, 373K and 383K. Once a month, and for a period of seven months, the QM for each
sample was measured and recorded.

Do the following:

• Determine the shelf life of the product at 293K.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Degradation1” Degradation Analysis Folio. 

Solution

• Add a Degradation Analysis Folio to the project.

• In the Degradation Folio Setup window, select the first stress, Temperature, and enter 293 in the Use
Value field for that stress. Click Finish to create the Degradation Analysis Folio.

• Enter the data into the Data Sheet. 

• In the Control Panel, select Exponential for the Degradation Model and type 50 for the Critical
Degradation. There is no Suspension Time for this example.
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• The Data Sheet will look similar to the one shown next. Be sure the data set is entered as given in the
table. All of the data that are applicable for this example do not appear in the next figure, as there are
105 rows of data.

• Calculate the parameters by selecting Calculate from the Data menu or by clicking the Calculate icon.

• To view the calculated parameters, click the Show Fit Parameters button in the Control Panel. To view
the extrapolated failure times, click the Show Extrapolated Values button.
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The parameter results are shown next.

• Click Close to close the Results Panel window.

• Plot the results in a new sheet by selecting Plot from the Data menu or by clicking the Plot icon. With
all units selected to be displayed, the plot will look like the one shown next.

• To transfer the extrapolated failure times to a Standard Folio, return to the Data Sheet and select
Transfer Life Data to New Folio from the Data menu or click the icon. 
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• Double-click the newly created Standard Folio in the Project Explorer to open the new Standard Folio
that the failure and suspension times were transferred to.10 Select Arrhenius as the life-stress model
and Weibull as the distribution. Calculate the parameters. The Folio will look like the one shown next.

Note that the Specialized Folio that you created for the degradation analysis is now associated with the
Standard Folio that you transferred the data to. You can click the link at the bottom of the Control Panel to
open the associated Degradation Analysis Folio. In addition, if you change and re-calculate the degradation
analysis, the associated Standard Folio will be updated automatically.

10.If you are using the Training Examples.ralp file included with the software, the “Transferred from Degradation” Stan-
dard Folio contains this information.
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• Open the Quick Calculation Pad. Perform a calculation for Warranty (Time) Information using 293 for
the use stress level and 0.9 for the required reliability. The results are shown next.

Using the Degradation Analysis Folio and the QCP, the shelf life is calculated to be about 15.6 months.

• Close the QCP.

• Close the Standard Folio and the Degradation Analysis Folio, save any changes, then proceed to the
next example.

4.13  Example 13: Performing a Likelihood Ratio Test
Consider the data summarized in the following table.

This data set illustrates a typical 3-level, constant accelerated stress. The stress in this example is
temperature and the Arrhenius life-stress relationship will be used. In this case, the Stress Profile is constant
and each stress level can be considered a different profile. The use stress level is 300.

Do the following:

• Obtain the parameters of the model.

Temperature

Time-to-Failure

406 K 416 K 426 K
248 164 92
456 176 105
528 289 155
731 319 184
813 340 219

543 235
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• Perform a likelihood ratio test to validate the assumption of a common shape parameter across three
stress levels.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the
“Likelihood Ratio Test” Folio.

Solution

• Create a new Standard Folio for non-grouped times-to-failure data. On the first page of the Data Sheet
Setup window, make sure none of the options are selected.

• On the second page, select Temperature as the stress type and set the Use Value to 300. Click Finish to
create the Folio.

• Enter the data and calculate the parameters using the Arrhenius life-stress model and the Weibull
distribution.

The estimated parameters are found to be:

beta = 2.9658
B = 1.0680E+4
C = 2.3966E-9

• Next, create a Probability plot of the data. Select to show the probability scales on the plot by selecting
Show/Hide Items from the Plot menu. In the Show/Hide Plot Items window, select the Probability
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Scales checkbox and click OK. You will need to adjust the scaling of the plot, using 1,000 for the upper
X-axis.

• You can also perform a likelihood ratio test to validate the assumption of a common shape parameter
across the three stress levels. To do this, return to the Data Sheet and click the Likelihood Ratio Test
icon on the Main Page of the Control Panel,

or select Likelihood Ratio Test from the Data menu. The Likelihood Ratio Test utility will appear.

• Enter .1 as the significance level and click Calculate. The results will appear, as shown next. 

• The value for the likelihood ratio test statistic, T, is less than the value of the chi-square. Therefore, the
shape parameter estimates do not differ statistically at the 10% level and it can be stated that the shape
parameter remains constant across the three stress levels.
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• Exit the Likelihood Ratio Test utility.

• Close the Standard Folio, save any changes, then proceed to the next example.

4.14  Example 14: Creating an Accelerated Life Test Plan
A reliability group in a semiconductor company is planning an accelerated test for an electronic device. 30
test units will be employed for the test and the test is planned to last for 600 hours. Temperature and voltage
have been determined to be the main factors affecting the reliability of the device. The normal use conditions
of the devices are 300K for temperature and 4V for voltage. The purpose of the experiment is to estimate the
B10 life of the device. The reliability engineer wants to use a three-level optimum plan because it will be
easier to manage than a five-level test plan. 

Based on engineering knowledge, data from a previous design and data from a pilot test, the following
information is available:

• An Arrhenius model is assumed for the life-stress relationship associated with temperature and is
accurate up to 360K.

• A power model is assumed for the life-stress relationship associated with voltage and is accurate up to
10V.

• The beta parameter for the underlying Weibull distribution is estimated to be 3.

• The probabilities of failure for the product at the end of the test are estimated as follows:

•  Stress 1 = Usage Stress, Stress 2 = Usage Stress: 0.02

•  Stress 1 = Highest Stress, Stress 2 = Usage Stress: 0.9

•  Stress 1 = Usage Stress, Stress 2 = Highest Stress: 0.6

Do the following:

• Create a Test Plan.

• Evaluate the generated Test Plan.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples.ralp.” Use the “Test
Plan1” Test Plan.

Solution

• With the “Training Examples.ralp” project open, add a new Test Plan to the project. 
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• In the Setup Window, enter the given information as shown next.

• Click Generate to generate the Test Plan, as shown next.

The Test Plan specifies that 6 units be tested at 360K and 10V, 11 units be tested at 300K and 8.5 V and the
remaining 13 units be tested at 337.4K and 4V. Tp, which is the estimate of the time when 10% of the units
will have failed at use stress (i.e. B10 life), is 1040.5 hours.
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To evaluate the Test Plan, you can solve for any one of three criteria (confidence level, bounds ratio or
sample size) given the two other criteria. The bounds ratio is the ratio of the upper confidence bound to the
lower confidence bound on Tp.

• In the Control Panel, select to solve for Bounds Ratio. Enter 0.9 for the confidence level and 30 for the
sample size then click Calculate Results. 

The bounds ratio is calculated as 1.92,  as shown next. 

If this calculated bounds ratio is unsatisfactory, you can calculate the required number of units that would
meet a certain bounds ratio criterion. 
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• In the Control Panel, select to solve for Sample Size. Enter 1.5 for the bounds ratio (note that the
confidence level is retained) then click Calculate Results. The required sample size is calculated to be
78 units, as shown next. 

If the sample size is kept at 30 units and a bounds ratio of 1.5 is desired, the equivalent confidence level we
have in the test is calculated to be 69.34%, as shown next.

• Close the Test Plan, save any changes, then close the project.



5  ALTA 7 PRO Examples                                  

The following examples use time-varying stresses, life-stress relationships and other utilities/
functionalities that are only available in ALTA 7 PRO. Thus, these examples can only be performed
using ALTA 7 PRO. Chapter 4 presents examples that can be performed using ALTA 7 Standard.

• Example 15: Simple Step-Stress - page 69

• Example 16: Multiple Time-Varying Stresses - page 74

• Example 17: Percentage Stress - page 79

• Example 18: Analyzing Multiple Stresses With the General Log-Linear Model - page 82

• Example 19: Using Time as a Stress - page 88

• Example 20 Time-Varying Use Stress Levels - page 94

• Example 21: Quantifying Acceleration Factors with the Proportional Hazards Model - page 101

• Example 22: Estimating Warranty Returns - page 107

5.1  Example 15: Simple Step-Stress
An electronic component was subjected to a voltage stress, starting at 2V (use stress level) and
increased to 7V in stepwise increments. The following steps were used to apply stress to the products
under test: 0 to 250 hr, 2V; 250 to 350 hr, 3V; 350 to 370 hr, 4V; 370 to 380 hr, 5V; 380 to 390 hr, 6V;
and 390 to 400 hr, 7V.  

Eleven units were available for the test. All eleven units were tested using the same Stress Profile.
Units that failed were removed from the test and their total time on test was recorded. The following
times-to-failure were observed in the test: 280, 310, 330, 352, 360, 366, 371, 374, 378, 381 and 385
hr.
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Do the following:

• Determine the mean life (often called MTTF or MTBF) and B(10) life of these components at the
normal use stress level of 2V.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“Simple Step-Stress” Folio.

Solution

• Create a new project with a Standard Folio for ungrouped times-to-failure data with voltage as the stress
type. Set the use stress level as 2V.

• Add a Stress Profile to the project by selecting Add Stress Profile... from the Project menu or by right-
clicking inside the Project Explorer and selecting Add Stress Profile... from the shortcut menu.

In a Stress Profile, you can define a time-varying stress in segments. The stress for each of these segments
can be a constant value (as in the case of this example) or defined as a function of time.

• Enter the data in the Data Sheet, as shown next.

• Update the Stress Profile by clicking the Calculate icon.

• Next, plot the Stress Profile by clicking the Plot icon. 
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A Plot Sheet will be added to the Stress Profile, as shown next.

• Name the Stress Profile as Voltage Step by right-clicking it in the Project Explorer and selecting
Rename Item.

• Close the Stress Profile and return to the current Standard Folio.

• On the Control Panel, select Cumulative Damage as the life-stress model and Weibull as the
underlying distribution.

• Click the Stress Transformation link. The Stress Transformation window will appear. Select
Logarithmic (Power LSR) as the transformation to be applied to the Voltage stress, as shown next, and
click OK. 
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• Enter the times-to-failure data in the Time Failed column, as shown next.

• Next, assign the Voltage Step Stress Profile to each data point by right-clicking a cell in the Voltage
column. A window will appear to display a list of all the Stress Profiles in the project, as shown next. 

• Click to select the Voltage Step Stress Profile and click Add to assign the profile to the data point. The
Stress Profile name will appear in the Voltage cell. Repeat this step to assign the Stress Profile to the rest
of the data points.
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• Calculate the parameters. The results are shown next.

• Open the QCP. Calculate the mean life for the voltage stress at the use stress level of 2V. (Note that
confidence bounds may be displayed if you have already been working with other examples in this
guide.)

The mean life of the components is calculated to be 1,046 hr.
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• Now calculate the B(10) life at the use stress level of 2V.

The B(10) life of the components is calculated to be approximately 508 hr.

• Close the QCP and the Folio.

• Save the project as Training Examples PRO.ralp.

• Leave the project open and proceed to the next example.

5.2  Example 16: Multiple Time-Varying Stresses
The cumulative damage model allows you to analyze accelerated life testing data with up to eight time-
varying stresses. In this example, we consider such a case and look at how to create stress profiles in which
stress is a function of time.

A sample of 18 units of an electronic component was subjected to temperature and voltage stresses. The
temperature was initially set at 100K (use stress level) and was then increased linearly to 200K over a period
of 20 hr. At 120 hr, the temperature was again increased to 300K over a 20-hr period. The voltage was
initially set at 4V (use stress level) and was then increased linearly to 8V over a period of 10 hr. At 110 hr,
the voltage was again increased to 12V over a 10-hr period. The following times-to-failure were observed in
the test: 171, 174, 192, 195, 200, 210, 220, 231, 233, 240, 242, 244, 245, 245, 250, 270, 271 and 274 hr.

Do the following:

• Determine the B(10) life of these components at the normal use stress levels of 100K and 4V.

• Determine how the B(10) life would change if the voltage use stress level were 2V instead of 4V.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“Multiple Time-Varying Stresses” Folio.
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Solution

• Create a new Standard Folio for ungrouped times-to-failure data with temperature and voltage as the
stress types. Set the temperature use stress level to 100K and the voltage use stress level to 4V.

• Add a Stress Profile to the project.

• Enter the data in the Data Sheet, as shown next.

Note that the periods during which the stress is being increased are represented as functions of time. The
mathematical formulas for these lines are easily obtained, as you have the starting and ending points for
each line.

• Update the Stress Profile by clicking the Calculate icon then plot the Stress Profile by clicking the Plot
icon. The plot of the Stress Profile will look like the one shown next.

• Name the Stress Profile as Temp Profile by right-clicking the item in the Project Explorer and selecting
Rename Item.
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• Add another Stress Profile to the project.

• Enter the data in the Data Sheet, as shown next.

• Update the Stress Profile by clicking the Calculate icon then plot the Stress Profile by clicking the Plot
icon. The plot of the Stress Profile will look like the one shown next.

• Name the Stress Profile as Volt Stress Profile by right-clicking the item in the Project Explorer and
selecting Rename Item.

• Close the Stress Profiles and return to the current Standard Folio.

• On the Control Panel, select Cumulative Damage as the life-stress model and Weibull as the
underlying distribution.

• Click the Stress Transformation link. The Stress Transformation window will appear. Select the
Reciprocal (Arrhenius LSR) transformation to be applied to the temperature stress and the
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Logarithmic (Power LSR) transformation to be applied to the voltage stress, as shown next, and click
OK. 

• Enter the times-to-failure data in the Time Failed column. Assign the Temp Profile to each data point in
the Temperature column and the Volt Stress Profile to each data point in the Voltage column then
calculate the parameters. The results are shown next.
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• Open the QCP and calculate the B(10) life of the component. Do not change the temperature or voltage
values in the Required Input from User section, as these are set to the specified use stress levels by
default. The results are shown next. 

The B(10) life at the use stress levels of 100K and 4V is found to be 814.07 hr.

• Change the voltage stress level by selecting Voltage from the drop-down in the Required Input from
User section. Change the value to 2V and calculate the B(10) life, as shown next.
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If the component is used at 100K and 2V instead of 4V, the B(10) life is found to be 919.97 hr. 

• Close the QCP and the Folio and save any changes. Leave the project open and proceed to the next
example.

5.3  Example 17: Percentage Stress
The cumulative damage life-stress model allows you to analyze accelerated life testing data with multiple
constant or time-varying stresses. This example provides another way to look at multiple stresses.

Consider a test in which multiple stresses were applied simultaneously to a particular automotive part in
order to precipitate failures more quickly than they would occur under normal use conditions. The engineers
responsible for the test were able to quantify the combination of applied stresses in terms of a “percentage
stress” as compared to typical stress levels (or assumed field conditions). In this scenario, the typical stress
(field or use stress) was defined as 100% and any combination of the test stresses was quantified as a
percentage over the typical stress. For example, if the combination of stresses on a test were determined to
be two times higher than typical conditions, then the stress on test would be said to be at 200%.

The test was set up and run as a step-stress test (i.e. the stresses were increased in a stepwise fashion) and the
time on test was measured in hours. The Stress Profile was as follows: until 200 hr, the equivalent applied
stress was 125%; from 200 to 300 hr, it was 175%; from 300 to 350 hr, it was 200%; and from 350 to 375 hr,
it was 250%. The test was terminated after 375 hr and any units that were still running after that point were
right-censored (suspended). Additionally, based on prior analysis/knowledge, the engineers stated that each
hour on test under normal use conditions (i.e. at 100% stress measure) was equivalent to approximately 100
miles of normal driving.

The test was conducted and the following times-to-failure and times-to-suspension under the stated Stress
Profile were observed: 

Times-to-Failure Times-to-Suspension
252 375
280 375
320 375
328
335
354
361
362
368
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After performing failure analysis on the failed parts, it was determined that the failure that occurred at 328 hr
was due to mechanisms other than the ones considered. That data point was therefore identified as a
suspension in the current analysis. The modified data set for this analysis was:

Do the following:

• Determine the B1 life for the part (i.e. time at which reliability is equal to 99%) at the typical operating
conditions (i.e. stress = 100%), in miles.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“Percentage Stress” Folio.

Solution

• Create a new Standard Folio for times-to-failure data with suspensions. Select Other as the stress type,
change the stress name to “Percent Stress” and set the use stress to 100. 

• Once the Folio has been created, add a Stress Profile to the project. 

• Enter the data in the Data Sheet, then plot the Stress Profile by clicking the Plot icon. The Stress Profile
will look like the one shown next.

• Name the Stress Profile as Automotive by right-clicking it in the Project Explorer and selecting
Rename Item.

• Close the Stress Profile and return to the current Standard Folio.

Times-to-Failure Times-to-Suspension
252 328
280 375
320 375
335 375
354
361
362
368



ALTA 7 PRO Examples ALTA 7 PRO

http://ALTA.ReliaSoft.com     81

• On the Control Panel, select Cumulative Damage as the life-stress model and Weibull as the
underlying distribution.

• Click the Stress Transformation link. The Stress Transformation window will appear. Select
Logarithmic (Power LSR) as the transformation to be applied to the Percent Stress, as shown next, and
click OK.

• Enter the observed times and state (failed or suspended) into the Data Sheet. Next, assign the
Automotive Stress Profile to each data point by right-clicking each cell in the Percent Stress column and
selecting Automotive from the window that appears. 

• Calculate the parameters. The results are shown next.



ALTA 7 PRO Examples ALTA 7 PRO

82     http://ALTA.ReliaSoft.com

• Open the QCP and calculate the B(1) life of the component at the use stress level of 100%. The results
are shown next. 

The B(1) life is found to be 657 hours. Based on the given multiplier, the B(1) life in miles would then be
657 test-hr*100 (miles/test-hr)= 65,700 miles. 

• Close the QCP and the Folio, save any changes, then leave the project open and proceed to the next
example.

5.4  Example 18: Analyzing Multiple Stresses With the General Log-Linear
Model
In many cases, the life of a product is a function of stress and some other engineering variable, such as
material, vendor or operation type. For this type of product, ALTA 7 PRO provides the general log-linear
life-stress relationship, which allows you to analyze up to eight stress types and specify an underlying
relationship for each stress. This example demonstrates the use of this model.

A sample of electronic components was subjected to a quantitative accelerated life test in which three stress
types were applied to the units. The stress types included temperature, voltage and a third indicator variable
to describe whether the units were operated continuously or turned on and off. The Stress Profile for this test
is presented in the first table and the time-to-failure and time-to-suspension data are presented in the second
table. The normal use stress levels are 328K for temperature and 10V for voltage.

Profile Temp (K) Voltage (V) Operation Type
A 358 12 On/Off
B 358 12 Continuous
C 378 12 On/Off
D 378 12 Continuous
E 378 16 On/Off
F 378 16 Continuous
G 398 12 On/Off
H 398 12 Continuous
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Do the following:

• Specify a transformation relationship for each stress type and estimate the parameters using the general
log-linear life-stress relationship.

• Determine which of the stress types has a greater effect on the life of the product in terms of
accelerating failure.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“GLL Multiple Stresses” Folio.

Solution

• Create a Standard Folio for grouped times-to-failure with suspensions data with three stress columns for
temperature, voltage and operation type. 

• Once the Folio has been created, insert a Subset ID column into the Data Sheet by clicking the Add or
Remove Columns icon on the Control Panel. 

• In the Add or Remove Columns window that appears, select Insert Subset ID Column, as shown next,
and then click OK. 

• Once the Subset ID column has been inserted into the Data Folio, double-click the column heading to
open the Change Headings window. Rename the column heading to Stress Profile to identify the
column as the one in which the Stress Profile identifier will be entered.

Time (Profile) Time (Profile) Time (Profile) Time (Profile)
498 (A) 211 (D) 249 (E) 134 (G)
750 (A) 266 (D) 145 (F) 163 (G)
445 (B) 298 (D) 192 (F) 116 (H)
586 (B) 343 (D) 208 (F) 149 (H)
691 (B) 364 (D) 231 (F) 155 (H)
176 (C) 387 (D) 254 (F) 173 (H)
252 (C) 118 (E) 293 (F) 193 (H)
309 (C) 163 (E) 87 (G) 214 (H)
398 (C) 210 (E) 112 (G)

20 units suspended at 750 (B)
14 units suspended at 445 (D)

10 units suspended at 300 (F)
7 units suspended at 228 (H)
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• Select the checkbox in each of the three stress columns to indicate that all three columns will be used in
calculating the Folio.

• Enter the data into the Data Sheet, as shown next. In the Operation Type column, enter 0 or 1 to indicate
on/off or continuous operation, respectively.

• Next, select General Log-Linear as the life-stress model and Weibull as the underlying life
distribution. 

• Click the Stress Transformation link to open the Stress Transformation window. In this window, you
can specify the transformation relationship for each stress type. For this example, the temperature stress
follows an Arrhenius model, the voltage stress follows a power model and no transformation will be
performed on the operation type. The Stress Transformation window will look similar to the one shown
next.

• Click OK to accept your selections and close the window. 
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• Calculate the parameters. The calculated parameters are shown next.

• Next, plot the parameters on a Weibull Probability plot. (You may need to change the scaling of the plot
to 1000 for the upper X-axis.) The plot will look similar to the one shown next.

The Weibull Probability plot can be used to examine the choice of an underlying life distribution and the
assumption of a common slope (shape parameter) at all stress levels. The linearity of the data and the fact
that the data for each stress level appears parallel reinforce the assumptions made.
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• Next obtain the Life vs. Stress plot for temperature, as shown next. (You may need to return the settings
to Automatic Scaling.)

Life vs. Stress plots can be very useful in assessing the effect of each stress on a product's failure. In this
case, since the life is a function of three stresses, three different Life vs. Stress plots are available. The
above plot was created by holding the voltage and operation type stresses constant at the desired use
level and varying the temperature stress. The method to create a Life vs. Stress plot where the voltage
varies is presented next. 

• Use the Use Stress Level window to create a Life vs. Stress plot for voltage by clicking the Set Use
Stress link on the Plot Sheet Control Panel.

• In the Use Stress Level window, click the Vary option next to Voltage and click OK. 
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• The Life vs. Stress plot for voltage will appear, as shown next. 

• Finally, select to vary the operation type in the Use Stress Level window and click OK. 

• The Life vs. Stress plot for operation type will appear, as shown next. 

In this plot, the effects of two different operation types on life can be observed. You can see that the
on/off cycling has a greater effect on the life of the product in terms of accelerating failure than the
continuous operation. In other words, a higher reliability can be achieved by running the product
continuously.

• Close the Folio, save any changes, then leave the project open and proceed to the next example.
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5.5  Example 19: Using Time as a Stress
A specific consumer product (e.g. a mouthwash, shampoo, etc.) is made up of three main ingredients
(ingredients A, B and C) that have a characteristic (e.g. concentration) that may or may not change with
time. A quantitative measure of the characteristic can be obtained and this measure must be within a
specified range for compliance. If any measure is outside its specified range, then the product is out of
compliance and considered to be failed. There are no known dependencies among these ingredients. Thus,
they are assumed to be statistically independent.  

For this study, 40 random specimens were stored at normal use conditions. At 3, 6, 9 and 12 months, 10
specimens were removed and measured. The measurement process is a destructive test (i.e. when the
specimen is opened for testing, the required readings are taken and that specimen is then disposed of).
Measurements for each ingredient at each time period are given in the following tables.

The acceptable range for each ingredient is shown next. 

If viewed from a "traditional reliability" perspective, the test in this example is not an accelerated test.
However, its analysis will require that we employ the fundamental principles of QALT analysis. The
measured value of each characteristic (as measured after each holding period) can be viewed as the random
variable (the time value in standard QALT analysis) affected by the aging process (the stress value). In other
words, the stress on each sample is the time in the holding cell and the random variable (what we
traditionally think of as time-to-failure) is the value of the measured characteristic.

Acceptable Range
A B C

Low 142 155 110
High 156 185 135
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Do the following:

• The product has a shelf life of 24 months. Using the lognormal distribution along with a General Log-
Linear model, determine the probability that a given specimen will be out of compliance at/after this
time period. 

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“Time As a Stress” Folio.

Solution

• Create a new Standard Folio for times-to-failure data. Select Other as the stress type, change the stress
name to “Age” and set the use stress to 1.

• In the new Folio, rename the Time Failed column to “Char. Value.” Enter the data for ingredient A. 

• Select General Log-Linear as the life-stress relationship and open the Stress Transformation window
to specify an untransformed relationship by selecting None.

• Select the Lognormal distribution and calculate the parameters, as shown next. (Please note that the
figure shown next displays only 20 rows of data. Be sure to enter all of the data for this example as
given in the table on page 88. Your Data Sheet will contain 40 rows of data.)  

• Next, plot the Life vs. Stress plot with 90% two-sided confidence intervals. Change the scaling of the
plot to reflect the acceptable range for product A. 
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• As can be seen from the plot shown next, no increase or decrease in the characteristic is noted. In other
words, age (at least up to the 12 months of observation) does not appear to affect the characteristic for
this ingredient.

• Next, use the QCP to determine the probability that ingredient A will be below the limit after 24
months, as shown next. Also determine the probability that ingredient A will be above the limit after 24
months.

The probability of ingredient A being below limit after 24 months is 0.02% and the probability of
ingredient A being above limit after 24 months is 0.03% 
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• Close the QCP.

• Insert a new Data Sheet with the same settings as the first one into the Folio by selecting Insert Data
Sheet from the Folio menu.

• In the new Data Sheet, enter the data for ingredient B. Calculate the parameters using the same settings
from the ingredient A analysis, as shown next. (Again, only 20 of the 40 rows of data are displayed in
this figure.) 

• Plot the Life vs. Stress plot with 90% two-sided confidence intervals. Change the scaling of the plot to
reflect the acceptable range for product B. As can be seen from this plot, there is a noticeable decrease
in the characteristic.
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• Use the QCP to determine the probability that ingredient B will be below the limit after 24 months, as
shown next. Also determine the probability of ingredient B being above the limit after 24 months.

The probability of ingredient B being below the limit after 24 months is 0.23% and the probability of
ingredient B being above the limit after 24 months is 0.00% 

• Close the QCP and insert a third Data Sheet into the Folio, using the settings given previously.

• Enter the data for ingredient C and calculate the parameters using the same settings from the ingredient
A and B analyses, as shown next (with 20 of the 40 rows of data displayed). 
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• Plot the Life vs. Stress plot with 90% two-sided confidence intervals. Change the scaling of the plot to
reflect the acceptable range for product C. As can be seen from this plot, there is a noticeable increase in
the characteristic.

• Use the QCP to determine the probability that ingredient C will be below the limit after 24 months, as
shown next. Also use the QCP to determine the probability that ingredient C will be above the limit.

The probability of ingredient C being below the limit after 24 months is 0.00% and the probability of
ingredient C being above the limit after 24 months is 17.83%.
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• The results from the QCP calculations for each ingredient are shown next.

In this case, the main contributing factor will be the the probability that ingredient C exceeds the limit,
which is significantly high. Having identified ingredient C as the main cause of failure, appropriate
corrective actions may be required.

• Close the QCP and the Folio, save any changes, then leave the project open and proceed to the next
example.

5.6  Example 20 Time-Varying Use Stress Levels
A new design is being considered for tanks that are intended to be used with heat exchangers for automotive
applications. It is desired to estimate whether the new design will meet its intended target before releasing it
to production. The target is a reliability of 90% at 2,000 hr of use, with a 90% confidence. 

The stimulus that has the greatest effect on the life of the tanks is pressure, measured in pounds per square
inch (psi). In order to perform an accelerated life test on these tanks, groups of tanks were put on a pressure
cycling test. This test involves putting the tanks on a test fixture, pressurizing them to 5.5 psi and then
rapidly increasing the pressure to either 15 psi or 21 psi. The tanks are held at the elevated pressure for an
amount of time and then rapidly decreased to the original pressure. For each pressure cycle, the tank spends
80% of the time at the elevated pressure and 20% of the time at the “default” pressure of 5.5 psi. Since the
cycle repeats every 10 hr, each cycle can be thought of as a square wave. Thus, for each cycle, the tank is
held at 5.5 psi for 1 hr (one-tenth of the cycle), the pressure is rapidly increased to either 15 psi or 21 psi and
held for 8 hr (eight-tenths of the cycle), then the pressure is rapidly reduced to 5.5 psi and held for an
additional 1 hr. The test fixture is capable of increasing and decreasing the pressure of the test units in a
rapid fashion, so much so that the transitions between the pressure levels can be considered simultaneous for
the purposes of this test. 
 
The test was conducted with two groups of test units: 22 units were tested with the 15 psi profile and 10 units
were tested with the 21 psi profile. All of the units were tested to failure. That is, the Stress Profile was
repeated until all of the units on test had failed. The failure data set is contained in the following table:

Ingredient A Ingredient B Ingredient C

Below Limit 0.02% 0.23% 0.00%

Above Limit 0.03% 0.00% 17.83%

Time-to-Failure (hr) 
for 15 psi Profile

Time-to-Failure (hr) for 
21 psi Profile

2241 1175
2493 1369
3308 4238
4018 4392
4596 4774
4845 5109
5300 5156
5691 5422
5908 7189
6466 7551
6471 -
6720 -



ALTA 7 PRO Examples ALTA 7 PRO

http://ALTA.ReliaSoft.com     95

As can be seen from the data, the range of failure times for the 15 psi pressure cycling test (2241 – 12774 hr)
is larger than the range for the 21 psi test (1175 – 7551 hr), indicating an inverse relationship between life
and stress. However, the data set will need to be formally analyzed to see if this conjecture is correct. 

The anticipated Stress Profile for the tank under normal use conditions for a mission of 2,000 hr is 6 psi for
66.7% of its life, 11 psi for 25% of its life and 14 psi for 8.3% of its life.

Do the following:

• Create two accelerated Stress Profiles for the 15 psi pressure cycling test and for the 21 psi pressure
cycling test.

• Analyze the data with the Cumulative Damage-Weibull model and a Power relation to confirm whether
or not life is inversely proportional to stress.

• Create a use Stress Profile to describe the anticipated use stress level for the tanks.

• Estimate whether the new design will meet its intended target before releasing it to production.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“Time-Varying Use Stress” Folio.

Solution

• Create a new Standard Folio for times-to-failure data. Select Other as the stress type, change the stress
name to “Pressure,” enter “psi” for the units and set the use stress level to 1 psi.

• Add a new Stress Profile to the project by selecting Add Stress Profile... from the Project menu or by
right-clicking inside the Project Explorer and selecting Add Stress Profile... from the shortcut menu.

6742 -
7718 -
8658 -
8927 -
9809 -

10155 -
10536 -
11194 -
11590 -
12774 -

Time-to-Failure (hr) 
for 15 psi Profile

Time-to-Failure (hr) for 
21 psi Profile
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• In the Stress Profile Explorer, create a profile for the 15 psi pressure cycling test, as shown next. Make
sure to select Repeat Cycle to specify that the test repeats itself until the units fail.

• Plot the Stress Profile, as shown next.

• Name the Stress Profile as 15 psi by right-clicking it in the Project Explorer and selecting Rename
Item. Close the Stress Profile.
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• Add another new Stress Profile. Enter the segments/stresses for the 21 psi pressure cycling test, as
shown next. Remember to specify that the test repeats itself. 

• Update the profile by clicking the Calculate button, then close it.

• Name the Stress Profile 21 psi.

• In the Standard Folio, select Cumulative Damage as the life-stress model and Weibull as the
underlying distribution.

• Click the Stress Transformation link and select the Logarithmic transformation (i.e. the power life-
stress relation), then click OK.

• Enter the times-to-failure data from the failure data set and assign the corresponding Stress Profile (15
psi or 21 psi) to each data point, as shown next. (Please note that the figure shown next displays only 24
rows of data. Be sure to enter all of the data for this example as given in the table on page 94. Your Data
Sheet will contain 32 rows of data.) 
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• Calculate the parameters. The results are shown next.

The parameter estimates resulting from this analysis are: 

Beta = 2.4553
Alpha(0) = 10.2545
Alpha(1) = -0.5278 

Note that the Alpha parameters are displayed in a single parameter field. Click the up/down arrows that
appear in the field to scroll through the Alpha parameters. The fact that the life-stress relationship
parameter α1 is negative confirms the hypothesis that life is inversely proportional to stress. 

• Now create the time-varying use Stress Profile for a mission of 2,000 hr. To do this, add a new Stress
Profile named Center Cycle and enter the segments/stresses for the use Stress Profile, as shown next.
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You can see that this profile has the highest stress in the middle of the profile, similar to the pressure
cycles that were used for the test Stress Profiles.

• Close the Stress Profile.

• Replace the static use stress value with the time-dependent Stress Profile that you have just created. To
do this, click the Set Use Stress link in the Control Panel to open the Use Stress Level window, select
Profile and select Center Cycle from the Use Stress Level drop-down, as shown next.

• Click OK to return to the Plot sheet. Select the Reliability vs. Time plot type.
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• The Reliability vs. Time plot for the analysis with the time-varying use Stress Profile is shown next.
Change the scaling of the plot to reflect the 2,000 hr mission time (X-axis). You may also need to
change the scaling to 0.95 for the lower Y-axis and 1.0 for the upper Y-axis to see the plot in detail.

• Use the QCP to calculate the reliability for the lower limit with 90% confidence bounds for a mission of
2,000 hr at the time-varying use Stress Profile, as shown next. You will need to select Show Confidence
Bounds and Lower One-Sided then specify a confidence level of 0.9 on the Confidence Bounds tab.

The 90% lower, one-sided reliability is calculated to be 92.80%. This exceeds the requirement of 90%
and the design can be released to production.
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• Close the QCP and the Folio, save any changes, then leave the project open and proceed to the next
example.

5.7  Example 21: Quantifying Acceleration Factors with the Proportional
Hazards Model
This example requires you to have Weibull++ 7.5 installed on your computer.

In this example, we look at a way of using the proportional hazards model to help quantify an acceleration
factor that can link reliability results from in-house testing labs and the reliability experienced by items in
the field.

In order to determine the acceleration factor between the test and the field, test data and field data from the
same model of the product must be compared. The test and field data are presented in the following table.
Note that the time units differ between the in-house test and the field data; the test data set is in hours and the
field data set is in months. Rather than converting one set of data to the other's time units, this discrepancy
will be dealt with after the data have been analyzed.

Do the following:

• Analyze the data with the Proportional Hazards-Weibull model to examine the relationship between lab
and field data.

• Use the Probability and Contour plots to validate the assumptions regarding the nature of the
relationship between test lab and field use.

• Determine the acceleration factor between the lab tests and the field.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“Proportional Hazards” Folio.

Solution

• Create a new Standard Folio for grouped times-to-failure data with suspensions and set Environment as
the stress factor.

• Enter the test and field data in the Data Sheet, using 0 to denote field use and 1 to denote lab testing.

Test Data 
Times-to-Failure (in hr)

Field Data
Times-to-Failure (in months)

50 18
92 8
97 10
98 11

102 13
110 14
122 16
70 17

144 18
47 -
- 11 units suspended 

at 19 months
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• Calculate the parameters using the proportional hazards model, as shown next.

• Next, create a Weibull probability plot with 90% two-sided confidence intervals to make sure that
assumptions regarding the nature of the relationship between test lab and field use are valid. Basically, if
the same failure modes are being attained at different stress levels, the slope of the Weibull probability
plot should be the same at the different stresses. This is shown in the following plot. 

• As the plot indicates, the data points for both environments conform closely to the calculated beta value
of 3.53. 
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• You can also use a Contour plot to examine the assumptions about the relationship. To do this, return to
the Data Sheet and send the data to Weibull++ by clicking the Transfer Data to Weibull++ icon on the
Control Panel,

or by selecting Transfer to Weibull++ from the Data menu.1 The software will automatically switch to
the Weibull++ application and the transferred data will appear in a Standard Folio, as shown next.

• Once the data has been transferred to Weibull++, use the Batch Auto Run utility to put the field use data
and the test data in two separate Data Sheets. Open the Batch Auto Run by clicking its icon on the
Control Panel.

1. Weibull++ can only be activated if version 7.5 or later is installed on your computer. Note that if you are using the
Training Examples PRO.ralp file included with the software, the Weibull++ Folio for this example is saved within the
project-- simply switch to Weibull++ to view it.



ALTA 7 PRO Examples ALTA 7 PRO

104     http://ALTA.ReliaSoft.com

• In the window that appears, click Select All Available. Both Subsets ID’s (0 representing the field use
data and 1 representing the test data) will appear under the Selected Subset ID’s area, as shown next.
Click OK. 

• The field use data will appear in the Data Sheet labeled “0” with the parameters calculated, as shown
next.
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• The test data will appear in the Data Sheet labeled “1” with the parameters calculated, as shown next.

• Next, add a MultiPlot to the Weibull++ project by selecting Add Additional Plot then Add MultiPlot
from the Project menu. 

• In the Select Warranty Subsets/Folio Data Sheets window that appears, select Folio1 Data Sheets 0 and
1, as shown next, and click OK.
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• Select Contour Plot as the plot type. In the Contours Setup window that appears, select to plot the 1st,
2nd and 3rd levels at 95, 90 and 85 percent, as shown next.

•  Click OK to create the Contour plot, as shown next.

The Contour plot indicates that the values of eta vary between the two environments, but the beta values
fall within the same range. This further supports the assumption that the units are undergoing the same
failure modes in both the lab and the field. 

• Return to ALTA by clicking the ALTA application button at the bottom of the Project Explorer. 
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• In ALTA, open the QCP and calculate the acceleration factor between the lab and field data. The results
are shown next (note that confidence bounds have been turned off on the Confidence Bounds tab). 

This calculation indicates that the acceleration factor from the field data (represented by stress level 1)
to the lab data (represented by stress level 0) is 4.7. In other words, the units in the field fail 4.7 times
faster than the units in the test lab.

Since the time units for the two data sets are different (the lab test times were in hours, while the field
data points were in months), we can say that 4.7 hours of time for this particular test is equivalent to one
month in the field. We have now quantified the acceleration factor between the lab testing and the field.

• Close the QCP and the Folio, save any changes, then leave the project open and proceed to the next
example.

5.8  Example 22: Estimating Warranty Returns
This example requires you to have Weibull++ 7.5 installed on your computer.

Consider an electric motor that has been designed for a washing machine. The actual load sizes for the
motors in the field will vary depending on the way that the individual user employs each machine. The
manufacturer provides a warranty of 1,000 cycles for this motor. In order to make adequate preparations to
support the warranty, the manufacturer wants to estimate the percentage of returns that can be expected
during the warranty period. The life of the motor is clearly dependent on the applied load and the applied
load varies based on customer usage patterns. In other words, there is a distribution that governs customer
usage. 
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The manufacturer tested the life of the motor at different loads with the following results:

Customer usage information was also available from similar applications, obtained by conducting a survey
on a representative sample of customers and recording the sizes of the loads that they placed into their
washing machines. A Weibull distribution was fitted to the data and the following parameters were obtained:

 beta = 2
eta = 6.2

Do the following:

• Determine the unreliability at 1,000 cycles using different loads.

• Estimate the number of returns that can be expected during the warranty period.

The file for this example is located in the “Training Guide” folder in your application directory (e.g.
C:\Program Files\ReliaSoft\ALTA7\Training Guide) and is named “Training Examples PRO.ralp.” Use the
“Warranty Returns” Folio.

Solution

• Create a new Standard Folio for grouped times-to-failure data with suspensions.  Select Other as the
stress type, change the stress name to “Load” and the units to “lb”.

Cycles-to-Failure Load (lb)
2386 6
3593 6
4045 6
6372 6
6448 6
1414 8
2147 8
3209 8
4026 8
4113 8
5117 8
6127 8
6352 8
819 12

1281 12
1441 12
1796 12
1856 12
2427 12
2645 12
2715 12
3671 12
4881 12

5 motors were suspended at 6500 cycles at the 6 lb load
1 motor was suspended at 6500 cycles at the 8 lb load
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• In the Data Sheet, rename the State End Time column to “Cycles to failure.” 

• Enter the data into the Data Sheet and calculate the parameters using the Weibull distribution and
inverse power law relationship, as shown next.

• The next step is to determine the unreliability at 1,000 cycles using different loadings. Use the QCP to
calculate the unreliability for a load of 7 lbs, as shown next.  
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• Continue to use the QCP to obtain values for loads of 5, 6, 8 and 9 lbs. These values are given (in
percent) in the next table:

Using this data set, we can obtain the distribution of the percentage of units failing during the warranty
period of 1,000 cycles at each load size. This can be performed using the free-form data type in
Weibull++ 7. 

• Activate Weibull++ 7 by clicking the Weibull++ application button at the bottom of the Project
Explorer. You will notice that the Standard Folio from the previous example is already present.

• Create a Standard Folio for free-form data.2

• In the new Weibull++ Data Sheet, enter the values that were obtained for each load and calculate the
parameters using the 2-parameter Weibull distribution with RRY for the parameter estimation, as shown
next.

• Insert another Data Sheet into the same Weibull++ Folio (i.e. select Insert Data Sheet from the Folio
menu) for ungrouped complete times-to-failure data.

• In the new Data Sheet, set the 2-parameter Weibull distribution and click Calculate. In the window that
appears, set beta = 2 and eta = 6.2 then click OK.

Now we have two distributions, one giving the percentage of units operating at each load size and the
other giving the percentage of units that fail at each load size during the warranty period of 1,000
cycles. The stress-strength interference analysis in Weibull++ can now be used to obtain the percentage
failing during warranty from the whole range of load sizes applied in the field. 

Load (lb) % Failing at 1,000 Cycles
5 0.42
6 0.81
7 1.39
8 2.24
9 3.38

2. Note that if you are using the Training Examples PRO.ralp file included with the software, the Weibull++ Folio for
this example is saved within the project-- simply switch to Weibull++ to view it.
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• To do this, activate the Stress-Strength Wizard by selecting Stress-Strength Calculations from the
Tools menu. 

• Set Folio 2 Data 1 as the Strength Set and Folio 2 Data 2 as the Stress Set. Click Calculate.

Based on this analysis, it is estimated that approximately 1.46% of the units will fail under warranty.

• Close the Stress-Strength Wizard.

• Return to ALTA by clicking the ALTA application button at the bottom of the Project Explorer. 

• Close the QCP and the Folio, save any changes, then close the project.





6  Practice Questions

The following practice examples can be performed using ALTA 7 Standard and ALTA 7 PRO. The
answers to these practice questions can be found in Chapter 7.

Create a new project in which to perform these practice questions.

6.1  Practice Question 1
The following data set was obtained from an accelerated test. Fifteen units were tested at 2200 rpm,
2500 rpm and 2800 rpm. The use stress level is 1500 rpm. 

1. Determine how you would classify this data set, i.e. non-grouped or grouped, with or without 
suspensions.

2. Create a new Data Folio and enter the data.

Stress Level, rpm 2200 rpm 2500 rpm 2800 rpm

Times-to-failure, hr

- 290 140
- 310 167
- 316 211
- 339 264
- - 309

Suspension time, hr

500 451 -
500 - -
500 - -
500 - -
500 - -
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3. Determine the parameters for this data set using the Inverse Power Law-Lognormal model.
4. Obtain the Lognormal Probability plot.
5. Obtain the Use Level Lognormal Probability plot.
6. Save your project as PracticeQuestions.rso7.
7. Close the Folio.

6.2  Practice Question 2
ACME Inc. Manufacturing has implemented an accelerated testing program for their new product design. A
total of 40 units were tested at four different pressure levels. The operating stress level is 170 psi.

1. Determine the parameters of the inverse power law life-stress relationship and Weibull distribution.
2. Obtain the Use Level Weibull Probability plot for this data set.
3. Plot the 90%, two-sided confidence bounds (Type II). Open RS Draw and save your plot as

MyPlot1.wmf.
4. Experiment with annotating the plot while in RS Draw.
5. From the plot determine:

i. The reliability of these units for a mission of 1,000 hr, R(1,000 hr).
ii. The 90%, two-sided confidence limits on the reliability for a mission of 1,000 hr (Type II).
iii. The mission duration for these units if ACME Inc. requires a 90% reliability at the 50% confidence

level.
iv. The mission range if ACME Inc. requires a 90% reliability at the 90% confidence level (Type I).

6. Using the Quick Calculation Pad, determine:
i. The reliability of these units for a mission of 1,000 hr, R(1,000 hr).
ii. The 90%, two-sided confidence limits on the reliability for a mission of 1,000 hr.
iii. The mission duration for these units if ACME Inc. requires a 90% reliability at the 50% confidence

level.
iv. The mission range if ACME Inc. requires a 90% reliability at the 90% confidence level.
v. The 90% two-sided confidence limits on the parameters.

7. Obtain the Reliability vs. Time plot for these units.
8. Obtain the Time vs. Stress plot for a 5% unreliability.
9. Obtain the Failure Rate vs. Time plot for these units. From the plot, what is the failure rate of these units

at 6,000 hr?

Stress Level, psi 220 psi 230 psi 240 psi 250 psi

Times-to-failure, hr

165 93 72 26
177 106 73 44
238 156 99 63
290 170 124 68
320 185 134 69
340 214 150 72
341 220 182 77
380 236 186 96
449 252 190 131
544 288 228 140



Practice Questions ALTA 7

http://ALTA.ReliaSoft.com     115

10. Obtain the Acceleration Factor vs. Stress plot. From the plot, what is the acceleration factor at 260 psi?
11. Save your file and close the Folio.

6.3  Practice Question 3
The following data set was obtained from an accelerated test in which temperature and humidity were the
accelerated stresses. The use stress levels are 348K for temperature and  0.20 for relative humidity.

1. Using the temperature-humidity life-stress relationship and Weibull distribution, determine the life for a 
90% reliability at the use stress levels.

2. Obtain the Life vs. Temperature plot.
3. Obtain the Life vs. Humidity plot.
4. Change the entered humidity values from decimals to percentages (i.e. from 0.4 to 40). Repeat Step 1

(note that the use level humidity is now 20). Do you see any difference in your estimation?

6.4  Practice Question 4
Open the Folio from Practice Question 2 (Folio2).

1. Insert a new Data Sheet for ungrouped complete data with no censoring into this Folio, using the same 
pressure stress. (You will now have an empty Data Sheet, as well as the one you saved from Question 2).

2. Copy the data from Question 2 and paste it into the empty Data Sheet. Delete the last ten entries for the
250 psi stress level. Use the inverse power law life-stress relationship and Weibull distribution to
calculate the parameters of the new data set.

3. Insert another Data Sheet for ungrouped complete data with no censoring into this Folio, using the same
pressure stress, and again copy the data from Question 2 and paste it into the newly created Data Sheet.
This time, delete the last twenty entries for the 240 psi and 250 psi stress levels. Calculate the parame-
ters for the inverse power law life-stress relationship and Weibull distribution.

4. Plot the Use Level Weibull Probability plot at 200 psi for each data set individually.
5. Plot the 90% two-sided confidence bounds and customize each plot to your liking.
6. Add a MultiPlot to the Folio and select the Use Level Weibull Probability plot for all three data sets to

be displayed. You may need to customize the colors using the Plot Setup in order to determine which
confidence bounds apply to each data set. What do you observe about the confidence bounds for each
data set, especially Data 3 with the 20 failures?

Time-to-Failure, 
hr

Temperature, 
K

Humidity

310 378 0.40
316 378 0.40
329 378 0.40
411 378 0.40
280 378 0.80
298 378 0.80
320 378 0.80
388 378 0.80
108 398 0.40
123 398 0.40
166 398 0.40
200 398 0.40
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7. Find the range of each confidence interval for each case using the QCP and for a 90% reliability at 200
psi. What happens to the confidence bounds when the number of test stresses increases? Why?

8. Close the Folio when you are finished and save the project.

6.5   Practice Question 5
In accelerated life data analysis, the pdf, the reliability and the failure rate are functions of both stress and
time. Thus, three-dimensional plots give you a good understanding of the behavior of such functions. 

1. Open the Folio from Practice Question 1 (Folio1).
2. Calculate the parameters using the inverse power law life-stress relationship and lognormal distribution.
3. Plot the Failure Rate Function using ALTA’s 3-D Plot utility.
4. Press Ctrl and click the plot. Simultaneously move the mouse in the direction you would like to rotate

the plot.
5. What is the behavior of the failure rate as time increases on a constant stress line?
6. When finished, leave the Folio open.

6.6  Practice Question 6
Once you have generated the data, created your plots and calculated what you wanted to calculate, the next
step is to generate a report. ALTA 7 allows you to do this very easily.

1. Folio1 should already be open.
2. Calculate the parameters if they are not calculated.
3. Create a Use Level Lognormal Probability Plot with 90% two-sided confidence bounds, then return to

the Data Sheet.
4. Click the Report Wizard icon in the Standard Folio Control Panel. The Report Wizard will appear,

with the “Data 1” Data Sheet in Folio1 already selected as the default data source.
5. Create a report based on the Single Constant Stress Template.
6. In cell C10, enter the use stress level (1500). In cell C11, enter the highest stress level used in the test

(2800). Leave the confidence bounds at their defaults of 5% and 95%.
7. Return to the Plot Sheet in Folio1, right-click the plot and select Copy.
8. Return to the Report and, in the Estimates and Two-Sided Confidence Bounds for Distribution Percen-

tiles section at the bottom of the Report, right-click in cell B49 and select Paste.
9. Resize the plot to your liking.
10. Close the Report and save the project.
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6.7  Practice Question 7
The Monte Carlo Data generator is a useful tool that allows you to generate values for any combination of
the available life-stress relationships and distributions. This example will take you through such a scenario.

1. Open the Monte Carlo utility by clicking its icon.

2. Generate a data set using the Eyring life-stress relationship and lognormal distribution with std = 0.3,
A = 2, B = 5,000. Create 25 data points for each of the two stress levels: 323 and 343.

3. Calculate the parameters.
4. Are the parameters equal to the ones used in the Monte Carlo generator? Comments?
5. Generate another Monte Carlo data set using the same distribution and parameters.





7  Answers to Practice Questions

The purpose of this section is to provide answers to the Practice Questions in Chapter 6. Due to the
structure and process required for Questions 6 and 7, answers are not provided.

7.1  Practice Question 1
1. Grouped times-to-failure with suspensions

3. = 0.2485, K = 1.6896E-21, n = 5.3571

7.2  Practice Question 2
1.  = 3.0092, K = 3.2679E-27, n = 10.2181

5. From the plot:

i. R(1,000 hr)  99.25%

ii. Upper CL  99.9%, Lower CL  94%

iii. Mission Duration  2,300 hr

iv. Requires a mission range of approximately 1,260 - 4,370 hr
6. From the QCP:

i. R(1,000 hr) = 99.19%
ii. Upper CL = 99.90%, Lower CL = 93.82%
iii. Mission Duration = 2,344.1964 hr
iv. Requires a mission range of 1,259.5799 - 4,362.7698 hr

v. : 2.4541, 3.6899, K: 1.3662E-31, 7.8166E-23, n: 8.3708, 12.0654

σ

β

≅

≅ ≅

≅

β
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9. Failure Rate  8.88E-04

10. Acceleration Factor  73.46

7.3  Practice Question 3
1. T = 1,008.6986 hr.
4. No, there is no difference.

7.4  Practice Question 4
6. The bounds for Data 3 are very wide.
7. Data 1: 313.6396 - 632.6267 hr

Data 2: 286.8053 - 643.2723 hr
Data 3: 328.8520 - 1167.7188 hr
There is less uncertainty in the extrapolation when the number of test stresses increases.

7.5  Practice Question 5
5. The failure rate increases.

≅

≅
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